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Welcome to The Print Shop Deluxe Companion. This exciting new
program lets you create a variety of stylish, professional-Iooking printed
materials that you'lI use every day in your business and personaliife.

The Print Shop Deluxe Companion's main publishing projects include
Certificates, Envelopes, Business Cards, and Post Cards. In addition, a
Name List feature lets you create and maintain a name list to merge into
mailings and other printed materials, the Smart Graphic feature lets you
create a library of custom-designed Initial Caps, Numbers, and
Timepieces, and Utilities let you create your own borders, and merge and
edit graphics libraries. The program contains an extensive collection of
high-quality scalable graphics and an array of backdrops and layouts that
make designing a project remarkably quick and easy.

With all these features, The Print Shop Deluxe Companion is truly the
program you've been waiting for. By allowing you to create the custom
printed materials you need in the quantities you want - ten or a hundred
- and giving you merge-print capability too, The Print Shop Deluxe
Companion will save you time and money. You'll be amazed at how
quickly and easily you can create dazzling, high-quality output.

If you own The Print Shop Deluxe, you'lI get even more benefit from
both products. The Print Shop Deluxe Companion provides backdrops
and design elements that complement many of the designs in The Print
Shop Deluxe, so you can create an entire stationery set, using business
cards and envelopes from The Print Shop Deluxe Companion, and
letterhead from The Print Shop Deluxe.

SPECIAL FEATURES OF THE PRINT SHOP DELUXE COMPANION

Scalable Graphics

Scalable graphics can be stretched, squeezed, and scaled with no loss of
quality. Make an image as large or as small as you want.

Color

Most Print Shop Deluxe Companion graphics are full color and print
beautifully on color printers. Even the monochrome graphics can be
highlighted with color accents. If you have a monochrome printer, don't
worry. All the graphics have been designed to print handsomely in gray
scale and patterns on monochrome printers as weil.
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New Style Graphics

In addition to a wealth of exciting new square graphics, The Print Shop
Deluxe Companion gives you horizontal row-shaped graphics and vertical

column-shaped graphics that are great for decorating the top, bottom, or
sides of a project. The graphics can be scaled, stretched, flipped, or
rotated for a wide range of interesting effects. For Certificates, The Print
Shop Deluxe Companion provides elaborate Certificate borders, plus Seal
graphics that can include your custom text.

TrueType Fonts

The Print Shop Deluxe Companion includes TrueType fonts. Like

scalable graphics, they can be freely resized without losing resolution.
No matter how big or how small you make it, your text remains smooth
and readable.

Headline Text

Special headline text lets you create eye-catching effects by adding
shapes and styles to one or two lines of text. See your words arch to the

margins, leap from the shadows, or balloon across the page l Stretch and
scale the headline text without any loss of resolution.

Rich Text

Rich text lets you alter your text on a character-by-character basis. Use

different fonts, styles, sizes, or colors on whatever words or characters
you choose.

Layouts

Using The Print Shop Deluxe Companion layouts is like having a

professional designer at your side. Closely tied to detailed backdrops or
designed for use with a textured backdrop, these layouts allow you to

easily place text and graphics in the most design-effective way. You'll get
top notch results in a snap even if you know nothing about design.
'What's more, it's easy to modify the layouts, customizing your design
until it suits your purposes exactly.
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Print Quality

The Print Shop Deluxe Companion provides printer support on a

"resolution independent" basis. This means that your printer's full
capabilities are utilized. Whether you use a dot matrix, ink jet, or laser
printer, you'lI get the highest resolution your printer can produce.

USING THIS MANUAL

This manual is your guide to understanding and appreciating all the

valuable features of The Print Shop Deluxe Companion. It teils you
everything you need to know to use the program and shows you how to

produce a wide range of useful, attractive, high-quality printed materials.

Getting Started

Chapter 2 teils you what's in The Print Shop Deluxe Companion box and

what equipment you'll need to run the program. It also teils you how to
install the program on your hard disko

Tutorial

Chapter 3 is a tutorial providing an overview of the main features of The
Print Shop Deluxe Companion with step-by-step instructions for creating

a certificate. By following the tutorial you'lI quickly grasp the basics of
making a Print Shop Deluxe Companion projeci.

The Basics

Chapter 4 describes in detail the basic steps involved in creating any
Print Shop Deluxe Companion project. These include: selecting a project

type; designing a project using backdrops, layouts, and various design
elements; saving and printing the projeci. In this chapter you'lI find basic
how-to information as weil as helpful tips for using the program's many

features.

The Projects

Chapter 5 describes each of The Print Shop Deluxe Companion
publishing projects in detail. The projects include: Certificates, Business

Cards, Envelopes, and Post Cards. This chapter also explains how to use
the Name List feature, how to create Smart Graphics, including Initial
Caps, Numbers, and Timepieces, how to create borders using the Make
a Border utility, and how to merge and edit graphics libraries.
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Chapter 6 describes each of the The Print Shop Deluxe Companion
commands available from the menus. The menus are File, Edit, Object,
Text, Project, View, and Goodies.

Graphics Exporter

Chapter 7 describes how to use the Graphics Exporter utility program
which enables you to export Print Shop Deluxe Companion graphics to
other applications.

Troubleshooting

Chapter 8 describes some common Print Shop Deluxe Companion
problems and their solutions. If you experience a problem with The Print
Shop Deluxe Companion, please read this section before calling for
technical assistance.

7
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The Print Shop Deluxe Companion Includes

The Print Shop Deluxe Companion Disks

The Print Shop Deluxe Companion Reference Manual

The Print Shop Deluxe Companion Graphics Reference Booklet

What Vou Need

Macintosh computer with a 68020 processor or higher, or PowerPC

System 7.0 or higher

1.4MB floppy disk drive

Hard disk with at least 6MB of free space

4MB of random-access memory (RAM)

100% Macintosh-compatible monochrome or color printer

Nice To Have

The Print Shop Deluxe for Macintosh

Color printer ribbons or cartridges

Specialty paper

INSTALLING THE PRINT SHOP DELUXE COMPANION

Installing The Print Shop Deluxe Companion is easy. The installation
procedure outlined below lets you install the entire program in just a few
simple steps.

Note: Before installing the program, you may want to make
backup copies of The Print Shop Deluxe Companion disks. The
disks are not copy protected. Once you have made copies, you
can store the original disks in a safe place and use the copies to
install the program.

There is a Read Me file that ships with The Print Shop Deluxe
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Companion. This file contains valuable information about The Print Shop
Deluxe Companion in general. You may want to take a moment to read
the file before installing the program on your system. Insert The Print
Shop Deluxe Companion Disk 1 into the floppy drive and double-click on
the Read Me file icon to launch it.

Installing the Program

1. Turn off all virus detection software (if you have any on your system).

2. Insert The Print Shop Deluxe Companion Disk 1 into the floppy drive.

3. Double-click on the Installer icon.

4. The Installer will displayamessage reconfirming the need to turn off
any virus protection software that may be running on your system. Click
OK after you have read the message.

5. Once you are in the Installer program itself, simply click on the Install
button to install The Print Shop Deluxe Companion on your hard drive.

6. The Installer will displayamessage telling you whether your system is
suitably equipped to run The Print Shop Deluxe Companion. Click
Continue after you have read the message.

7. Follow the prompts that tell you when to insert each Print Shop
Deluxe Companion disko

NOTE: The Installer will examine your system to see whether or
not you have a Macintosh with a 68020 microprocessor or
higher, or a PowerPC microprocessor. The appropriate
application will be installed based on the microprocessor
resident on your system.

While you are waiting tor The Print Shop Deluxe Companion to
be installed, take some time to till out the product registration
card included in the box. As a registered owner you'lI get:

• Notification of new versions of The Print Shop Deluxe Companion
• Discounts on new versions of The Print Shop Deluxe Companion
• Special offers on new products in the The Print Shop Deluxe family.

such as new Graphics Collections and Graphics Folios

• Free Technical Support
• Special offers on other Broderbund products

9
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Mail in the registration card today so you won't miss out on any of these

valuable benefits. You'lI be glad you did!

When you have completed the installation you will see a folder on your
hard disk entitled 'Print Shop Deluxe'.

IMPORTANT: You must now drag the Font suitcase to your
System folder. If you miss this step you will see numerous font
substitution messages when you try to use the program.

8. Double-dick on the Print Shop Deluxe folder to open it.

9. Drag The Print Shop Deluxe Companion Font suitcase out of the Print
Shop Deluxe folder and onto the dosed System folder on your hard disko
The system will ask you if it can automatically place the Font suitcase in

the correct folder within the System folder. Click OK.

NOTE: The Print Shop Deluxe Companion will run with any
TrueType font eorreetly installed in your System folder. Use of
Type 1 fonts and System fonts shipped prior to System 7.1
requires installation of their outlines in the System folder or the
use ofAdobe's ATM@ version 3.0 or later. We strongly
reeommend that you install at least one font provided with The
Print Shop Deluxe Companion. Installation of the New Zuriea font
will insure optimum sereen display and minimize font
substitutions.

IMPORTANT: Once you have installed the program, it is
important to leave the files and folders where they have been
plaeed in order to avoid navigation errors. The Print Shop
Deluxe Companion expeets to find the graphie libraries inside the
'Libraries' folder within the 'Print Shop Deluxe' folder on your
hard disko To avoid messages asking you to loeate the libraries,
leave them where they have been plaeed by the lnstaller.

STARTING THE PROGRAM

• Double-dick on the Print Shop Deluxe folder that has been created on
the drive you designated.

• Double-dick on The Print Shop Deluxe Companion icon.
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• The Personalization dialog will appear. Enter your name and click OK or

press Return.

• The Select A Project window will appear and you're ready to use The
Print Shop Deluxe Companion!

11
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l1's easy to create a project with The Print Shop Deluxe Companion. In
this quick tutorial you'll design a certificate using the program's main
features. By the time you finish, you'lI know the basics of designing any
Print Shop Deluxe Companion project. The certificate you create will look
like the certificate in the left margin.

Instructions

The instructions in this tutorial follow a two-step format. The numbered
steps tell you what action you are going to take. The bulleted steps tell
you how to take it. Characters you type and keys you press are printed in
boldface. This manual assumes that you are familiar with basic
Macintosh techniques. If this is not the case, please first read the
documentation provided with your Macintosh before continuing with this
tutorial.

If you know how to perform an action, simply perform it and ignore the
bulleted steps. If you are unsure of how to perform the action, proceed
through the bulleted steps one at a time.

For Example:

1. Start the program.

• Open the Print Shop Deluxe folder.
• Double-click on The Print Shop Deluxe Companion program

icon.

12

CREATING THE CERTIFICATE

To create the certificate, you will select a backdrop, choose a layout, and
fill it in.

Starting at the Select a Project window:
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• Cliek the Certificate button.
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Now deeide whether to make a Wide or Tall eertifieate.

2. Seleet a Wide eertifieate

• Cliek the Wide button.

The Select a Backdrop dialog will appear. The names of backdrops you
ean ehoose are listed at the left. To the right is a display area whieh
previews the seleeted backdrop. For this projeet. you'll seleet Blank

Page.

londscope

Ubrory: PSDC Bockdrops

Blonk Poge
Check
Grid
Koliedoscope
Unen
Noturol
Ripple
Snoke Skin
Stroight Une
Teor Drop

[ Chonge Ubrory... ) I 4i +.:;:, I ( Help ) ( Concel) ~ DK 11

3. Seleet the Blank Page fram the list of available backdrops.

• Cliek on Blank Page.

4. Leave the Select a Backdrop dialog

• Cliek OK.

13
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The Select a Layout dialog will appear, ready for you to select a layout.

Layouts are an important feature of The Print Shop Deluxe Companion.
They provide placeholders for graphics and text, making it easy for you to
produce a beautifully-designed project every time. As you move the

highlight bar through the list, the highlighted layouts will appear

superimposed on your certificate. Icons show what the gray layout
placeholders represent.

Londscope

o Lighten Bockdrop I 4J. '::::> I

Librory: PSDC Loyouts
No Loyout
Certificote 1
Certificote 2
Certificote 3
Certificote 4
Certificote 5
Certificote 6
Certificote 7
Certificote 8
Certificote 9

~'~~~~~~~~Ft~ CertificaI1 +--fl-- Title Bio

~"""""--+""-+f---*- Text Bio.
Seal Gra

Signatur

Help 1 (concel 1 n OK )l
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5. Select a layout for your certificate.

• Highlight Certificate 7.

• Click OK.

Once you have selected a layout, the document window appears. The

document window has a page, a floating tool palette, and a menu bar.

The title bar at the very top of the screen shows the name of the
document you are working on. The layout you selected is displayed on
the page. Now it's time to fill in the placeholders in the layout.

6. Fill in the Title Block.

• Double-click on the Title Block placeholder.

The Title Block dialog will appear. The Title Block is a special kind of text

block available only for certificates. It consists of a Title Line and one or
two Secondary Lines of text. Notice the cursor in the text box at the top
of the dialog. This is where you enter the Title Line.
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Title Block

[!]
Title Une:

ICertificate I
Secondary Unes:

I~eri~
I$";.'';';1'':';'\: <>

[ Customize... 1 size:[ Large Title/Small 2nd Une ",
Font: I ",Tribune [ Help )

Font: I Diploma "1 Color: I ", [ )
Shape: I,.... ", Cancel

Top Rrch
Style: 1 ",Plain ( OK )

lilie Une Secondary Unes _

7. Enter the Title Line text.

• Type Certificate

8. Change the font for the Title Line.
• Cliek and hold on the Fant popup menu in the Title Line box in the

lower left of the dialog.

• Highlight Dip/oma.

The new font will be displayed on the letter in the Effect box.

9. Enter the Seeondary Line text.
• Cliek in the Seeondary Lines text box.
• Type of and press Return.
• Type Merit

10. Change the font for the Seeondary Lines.
• Cliek and hold on the Fant popup menu in the Seeondary lines box

in the lower right of the dialog.

• Highlight Tribune.

11. Change the relative size of the lines of Title Block text.
• Cliek and hold on the Size popup menu in the center of the dialog.
• Highlight Large Title/Sma// 2nd Line.

12. Return to the doeument window.

• Cliek OK.

15
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You will be returned to the document window. The text you typed in the
Title Block dialog will appear on your project. You will notice that the
secondary lines of the Title Block are automatically positioned within the
open area created by the shape of the title line.

Now you're ready to fill in the text block.

13. Fill in the text block.

• Double-dick on the text block placeholder.
The text block will become active with a blinking cursor. This is where
you enter your text.

14. Enter three lines of text.

• Type This award presented to and press Return.
• Type Margaret Adams and press Return.
• Type for outstanding achievement in sports.

You can edit the text in a variety of ways using the Text menu on the

menu bar.

15. Change the font and size for the middle line of text.

• Highlight the middle line of text by dragging the cursor over
the text.

• From the Text menu, open the Fant submenu and
select Dip/oma.

• From the Text menu, open the Size submenu and select
Medium (36).



• • • • • Tutorial

Now you're ready to work on the Signature Block wh ich appears as a
series of lines displayed on your project.

16. Fill in the Signature Block.

• Click on the Pointer tool.
• Double-click on the Signature Block lines.

The Edit Signature dialog will appear. On the left side of the dialog are
boxes for entering names or other text to be printed beneath the
signature lines.

Edit Signilture

TeHt Under Signilture: Hutogrophs:
r[N-on-e------...--.1

[None "'1

Color: ~I~~~~~"'~l
100% "'l

Font: I Tribune

Size: I Medium Lilrge

Justify: I Center

"'1 r--=--=----~,_____::_~I Chilnge Hrrilngement 1[ "elp
(4)"'1 '---:';:::=~~;;:;;;;;~;;;;;;~

"'1 [Cilntel) n OK ))

17. Enter text.

• In the first text field, type President
• Click in the second text field or press the Tab

key once, and type Vice President

You can choose autographs of famous people to print on the signature
lines. For now, though, leave the Autographs field set at None and
continue with your certificate design.

18. Return to the document window.

• Click OK.

The text you typed in the Signature Block dialog will appear beneath the
signature lines on your project. Now proceed to fill in the Seal.

19. Fill in the seal.

• Double-click on the seal placeholder.

17
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The Seal dialog will appear. A Seal is a circular graphie available for
certificates only. It has a decorative center, an edge, and up to two lines
of text placed between the center and the edge.

Seal

Seal TeHt: Seleet Graphie:

Top: I[Heellenee in Rehieuemell Seal [dge ...

Bottom: 1199~ I

Font: I
:========::::

Item: 1'- ..1

Color: I

l8l Bullets [preuiew TeHt 1 [ Help 1( Caneel 1n OK 1)

20. Select a center graphie for the seal.

• Click on the Seal Center... button. The Select a Seal Center dialog
will appear.

• Highlight Classic.

• Click OK.

21. Select an edge graphie for the seal.

• Cliek on the Seal Edge... button. The Seleet a Seal Edge dialog
will appear.

• Highlight Classic.

• Cliek OK.

22. Enter seal text.

• Cliek on the top text field.

• Type Excellence in Achievement
• Cliek on the bottom text field.

• Type 1995

23. Change the font.

• Cliek on the Fant popup menu.

• Highlight Tribune.

24. Seleet the Bullets option.

• Click on the Bullets eheekbox.



• • • • Tutorial

25. Preview the seal text.

• Click the Preview Text button.

The seal text will appear on the seal in the display area, with bullets
separating the top and bottom text. You could continue to work on the
seal, experimenting with different centers and edges. For now, leave the
seal the way it is and return to the document window.

26. Return to the document window.

• Click OK.

Now you're ready to fill in the last placeholder in the layout. This is the
certificate border.

27. Fill in the border.
• Double-click on the border placeholder.

The Select a Border dialog will appear.

80rder Graphie

library: PSDC Certifieate

No Graphie
Classie
Cross Stiteh
Doodle
Dots
Double Heauy
Double light
Filigree
Florentine

( Change library... ) Help 1[ Caneel 1 n DK Jl

28. Select a border.

• Highlight Classic.
• Click OK to return to the document window.

Once you've filled in the layout. you can add additional graphics or text to
the certificate if you want. A square graphie would add a nice touch to
this design.

19
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29. Add a square graphie (optional).

• Cliek and hold down the mouse button on the New Object tool in
the tool palette. A list of objeets you ean add to your projeet
will appear.

• Highlight Square Graphie.

• Release the mouse button.

A square graphie plaeeholder will appear in the center of the page. You
ean move the plaeeholder wherever you want.

30. Move the square graphie plaeeholder.

• Cliek and hold down the mouse button on the plaeeholder.
• Drag the mouse to move the plaeeholder to the lower-Ieft corner

of the eertifieate.

31. Seleet a square graphie.
• Double-cliek on the square graphie plaeeholder. The Seleet a

Square Graphie dialog will appear.
• Seroll down the square graphies list to Trophyand highlight it.

• Cliek OK.

The trophy graphie will appear on your projeet. If you don't like where it is
plaeed, you ean move it just as you moved the plaeeholder.

As you ean see, it's easy to add new elements to your projeet. Though
using layouts is the fastest way to get satisfaetory results, you're not
obliged to use them. By adding new objeets one at a time, you ean
design a eomplete projeet from serateh. All of the objeets listed on the
New Object menu are available for your projeets, though Title Blocks,
Signature Blocks, and Seals are available only for eertifieates. For
eomplete information on the design elements, see Chapter 4, The
Basies.

SAVING THE CERTIFICATE

Now that you've eompleted your eertifieate you're ready to save it.

To save the eertifieate:

• Seleet Save from the File menu. The Save dialog will appear.
• Make sure the folder and drive to whieh you want the projeet

saved are eurrently seleeted. If not, navigate to the appropriate
folder and drive.



• • • • • Tutorial

• Type in a name for your project, such as Sports

• Click Save.

Ie Print Shop DeluHe "'1 = Hard Disk

<4l l: Hpod er ~ ( fjpl;1 )
o libraries
D PSnCJldp ( Desktop )
D HUHlMf
o ReadyMades ( New LJ )
<?l Ib> Plint Shop OduHe Cümp<L __ ......................... ...............

Saue as: ( Cancel )
IUntitled I n Saue Do Full Saue

For more information on saving, see Chapter 4, The Basics.

PRINTING THE CERTIFICATE

Now you're ready to print the completed certificate.

To print the certificate:

• Select Printfrom the File menu. The Print dialog will appear.

• Click OK.

Your certificate should print out on your printer. If it does not, check to
see that your printer is turned on and connected properly to your
computer. If you still have problems, consult your printer manual.

21
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The Print Shop Deluxe Companion contains four specialized publishing
projects. They are: Certifieate, Envelope, .Business Card, and Post Card.
The program also includes: a Name List feature that lets you create name
lists to merge into your publishing projects; a Smart Graphie feature that
lets you create Initial Cap, Number, and Timepiece graphics; and Utilities
that let you create your own borders and allow you to merge and edit
graphics libraries.

All of The Print Shop Deluxe Companion publishing projects work in
essentially the same way. This chapter discusses the basic steps you'll
follow to create any publishing project It teils you how to make initial
selections, including choosing a publishing project type, an orientation for
the project, a backdrop, and a layout. It explains how to fill in the layout
and how to design the project using the tool palette and menus. Finally,
it explains how to save imd print your work.

For more specific information on each publishing project as weil as
information on the Name List, Smart Graphic, and Utilities features, see
Chapter 5, The Projects.

MAKING INITIAL SELECTIONS

Return to PrOjec~

Menu button .. t ~!=>

When you start The Print Shop Deluxe Companion program, the Select a
Project dialog appears. You will begin the initial selection process by
choosing a project type, an orientation for the project, a backdrop, and a
layout that will serve as the basis for your design. During this initial
selection process only the File menu with a limited number of items,
including Open, and Quit, is available. Togo back to a previous screen,
click the Cancel button. To return to the Select a Project dialog from the
Backdrop and Layout dialogs, click the Return to Project Menu button,
or choose Newfrom the File menu.

Once initial selections are made, the document window will appear with
your project displayed. All the menus on the menu bar will become
available and a tool palette will appear. You can then proceed to fill in the
layout or add new elements. You can use the tool palette and the
menus to modify the design of your project.

22

Getting Help

Help is always available from within The Print Shop Deluxe Companion.
To select from a list of help topics, click the Help button when it's
available or select Help from the Apple menu. Additional help is
available by c1icking on the Balloon Help icon on the menu bar and
selecting Show Balloons. This will activate brief descriptions of onscreen
objects when your mouse passes over them.
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SELECTING A PROJECT TYPE

The publishing projeets you ean make with The Print Shop Deluxe
Companion are shown in the Select a Project window whieh appears
when you start the program. The publishing projeets are: Certificate,

Envelope, Business Card, and Post Card. (This dialog also lets you seleet
the Name List feature, the Smart Graphie feature, and the Utilities. Für
information on these features, see Chapter 5, The Projeets.)

T0 select a project:

• Cliek the button for the projeet you want.

To get a saved project:

• Cliek the Open a Saved File button, or ehoose Open from the
File menu.

• Choose the file you want fram the list in the dialog.

SELECTING AN ORIENTATION

After you seleet a projeet type, you must seleet a page orientation.
Orientation depends on the projeet.
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To select an orientation:

• Click the button for the orientation you want.

Note: If you are creating a certificate, this dialog will include a
button for Ready Made certificates. Click the Ready Made button
if you want to open a Ready Made certificate (see the Graphics
Reference Booklet for the assortment of Ready Made
Certificates)~

For complete information on orientation and other specifications for each
project, see Chapter 5, The Projects.

SELECTING A BACKDROP

When you have selected a project type and an orientation, the Select a
Backdrop dialog will appear. The dialog lists backdrops contained in the
current library. The name of the library appears above the list. The
currently highlighted backdrop is shown in the display area to the right of
the list.

landscape

Library: PSDC Backdrops

Blank Page
Check
Grid
Kaliedoscope
Linen
Natural
Ripple
Snake Skin
Straight Line
Tear Drop

( Change Library... ) I 4J. '.:;) I ( Help ( Cancel 1 t OK 11
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The Print Shop Deluxe Companion contains a wide variety of backdrops
especially designed for each project type. The backdrops work in
conjunction with layouts that provide spaces for graphics and text. You
will see layouts for the backdrop you have chosen when you proceed to
the next step (Selecting a Layout).
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To select a backdrop:

• Highlight the backdrop you want.

To get a backdrop from another library, click the Change library button,
open the Libraries folder if it's not already open, and then select the
library you want from the list that appears and click Open.

Choose Blank Page if you do not want a backdrop for your project or if
you want a solid-color or color-blend page. You'll have a chance to

choose a page color and blend color when the tool palette and menus
appear.

• Click OK.

SELECTING A LAVOUT

After you select a backdrop, the Select a Layout dialog will appear. A list
of available layouts is at the left of the screen. The highlighted layout
superimposed on the backdrop, is shown in the display area at the right.

londscope

librory: PSOC loyouts
No loyout ;}
Certificote 1
Certificote 2
Certificole 3
Certificole 4
Certificole 5
Cerlificole 6
Cerlificole 7
Certificole 8
Cerlificote 9 ""

D lighten 8ockdrop I "" +::J I ( Help ( Concel) ~ OK D

What Is a Layout?

A layout makes designing your project easy. Created by professional
designers, Print Shop Deluxe Companion layouts provide spaces for

graphics and text. The spaces are represented by gray object place-
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holders with identifying icons. These are arranged in various

combinations and configurations designed to work weil with the selected
backdrop. All you need to do to produce an attractive, effective, and
professional-looking design is to fill in the object placeholders with
graphics and text of your choice.

Once you have filled in the objects in the layout, you can use the tools
and menus to modify them in a variety of ways, including scaling,
resizing, moving, rotating, flipping, framing, and coloring. You can also

add objects or delete objects from the layout.

Title Block

___Row Graphic
__E=:III__t-- Ruled Line

Seal

___
Signature Block

Text Block T

The graphic and text objects included in layouts are: Square, Row, and
Column Graphics, Text Blocks, Headlines, Horizontal and Vertical Ruled
Lines, Mini-borders, and Borders. Certificate projects also include:
Signature Blocks, Seals, and Title Blocks, and Certificate Borders will

replace Borders.

Squa,e G,aphic-lll ~ Headline

Column Graphie
~

Mini-border -+"-f--+,D
Border

Which layouts will you see?

The layouts you will see depend on the backdrop you have chosen. lf you

have chosen a tiled pattern or blank page for your project, you will see
The Print Shop Deluxe Companion's entire list of generic layouts for the
current project. But if you have chosen a more specifically designed

backdrop you will see only those layouts that work weil with your
selection. For some backdrops the list may be as short as one or two

layouts. If you have chosen a detailed backdrop and want to see the
entire list of layouts, you can lighten the backdrop. When you do this, the
backdrop will fade to 40% of its original color and the entire list of generic
layouts will appear, just as it would if you had chosen no backdrop.
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To lighten the backdrop:

• Check the Lighten Backdrop box. The backdrop will be lightened
and the entire selection of layouts will become available.

• To return to full color strength, click the Lighten Backdrop
checkbox again.

Viewing a layout

To view a layout, highlight the layout you want to see. The highlighted
layout will appear in the display area superimposed on the backdrop.

To select a layout:

• Highlight the layout you want.

Choose No Layout if you do not want to use one of the pre-designed
layouts for your project. If you choose No Layout you can use the tools
and menus to add objects to your project, thus creating your own layout.

• Click OK.

Note: For Envelope and Post Card projects, you can choose either
layouts that conform to United States Postal Service (USPS)
requirements or layouts suitable for hand-delivered
correspondence. USPS layouts have some special characteristics.
See Chapter 5, The Projects, for details.

FILlING IN THE LAYOUT

When you have made all your initial selections, your project will be
displayed in The Print Shop Deluxe Companion's document window and
the tool palette will appear.

~ File [dU Oltjecl TeHI Pfojnl Uiew ttoodieJ (!J
~ Untltled,m,1 GM _.,s; .1io1 ~_ lii
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You are now ready to complete your project. If you have selected a
layout, you can do this quickly and easily by simply filling in the layout
with graphic objects and text of your choice. If you want to spend more
time you can go back and modify your design, using whatever tools and
menus you need. Or if you prefer, you can modify, add, and edit as you
go.

For complete information on using the tool palette and menus and
carrying out design operations, see Tool Palette, page 41, Menus, page
90, and Design Operations, page 45.

To fill in the layout:

• Double-dick on the placeholder for the object you want to fill in.
The appropriate dialog or edit mode will be displayed.

For information on each of the Print Shop Deluxe Companion's graphic
and text objects and how to fill them in, see Design Elements, below.

DESIGN ELEMENTS
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The Print Shop Deluxe Companion contains many different design
elements to use in your projects. These include: Square, Column, and
Row Graphics; Text Blocks; Headlines; Borders and Mini-Borders; and
Ruled Lines. If you are working on a certificate, three additional objects
are available. These are: Signature Blocks, Seals, and Title Blocks; and in
certificates, Certificate Border will replace Border.

The layouts use the design elements in various combinations and
configurations. You can also add them to your projects yourself by using
the New Object tool or selecting Add from the Object menu. In fact,
using a layout is not required. If you prefer, you can build a project from
scratch simply by adding design elements to a blank page.

Each design element has its own selection dialog. The dialogs for square,
column and row graphics, and for borders, mini-borders, and ruled lines
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I
Ruled Line

-- Column Graphic

Mini-border

Row Graphie

~~

Bearlfine
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Square Graphie

T his iS

i1)
Titte Block

"...",

Seal ...
.. This is a text block.
- Type yovr message here.

Border

work in very similar ways. The dialogs for headlines, and for title blocks,
signature blocks, and seals in the certificate project work in various ways,
allowing for text entry, editing and customization. Text for text blocks is
entered direetly on the projeet in the document window and is styled via
the Text menu.

SQUARE, COlUMN, AND ROW GRAPHICS

The Print Shop Deluxe Companion provides a large and varied selection
of graphics suitable for many occasions and needs. All of these graphics
are fully scalable, which means they ean be made larger or smaller,
stretehed or squeezed, with no loss of quality. Square graphics fit within
a square box. Column and row graphics fit within a rectangular box.
Column graphics have a vertical orientation. Row graphies have a
horizontal orientation.

To fill in one of these graphic elements, simply double-click on the
placeholder. The appropriate graphic dialog will appear.
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Note: The Print Shop
Deluxe Companion
ineludes Square
graphie libraries that
provide fun imitation
"stamps" and
"postmarks " that you
ean add to your hand­
delivered envelopes
and post eards. In
addition, you ean use
any Smart Graphies
you create in the Print
Shop Deluxe
Companion in any
Print Shop Deluxe
Companion projeet.
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SQuare Graphie
library: PSOC SQuares .---------,

No Graphie " '*
Award
Blue Aibbon
Bright Car
Caetus
Confidential
Cow Ouer Moon
Oeeolpe
Earth
Earth Reeue!e .fJ<

D Rpp!y To RII SQuares

(Change library... J~ (canee!] n OK )1

On the left side of the graphie dialog is a list of graphics available fram the
currently open graphics library, named above. (If you wish to change the
library, click on the Change Library button, open the Libraries folder if it's
not al ready open, and then choose the library you want.) On the right is a
display area showing the currently highlighted graphie.

Below the list of graphics is an Apply to All checkbox (Squares,Columns
or Rows). To have the selected graphie fill all the same-type graphic
placeholders on your project (or on the current section, in the case of post
cards) click the checkbox. This is a quick way to fill in several placeholders
at once, pravided, of course, that you want the same graphic for all.

To seleet agraphie:

• Highlight the graphie you want.
• Click OK or double-click on the graphic name.

You will be returned to the document window. The placeholder will be
replaced by the graphie you selected.

BORDERS AND MINI-BORDERS

The Print Shop Deluxe Companion contains many decorative borders.
Borders come in small and large widths and always occupy the outside
edges of a project; they cannot be moved, scaled or stretched. Mini­
borders are decorative borders that can appear anywhere on a project.
They can be ratated, scaled and stretched, and come in small and large
widths. They are often used to frame graphics or text blocks.

To fill in a border or mini-border, simply double-click on its placeholder.
The Select a Border or Select a Mini-border dialog will appear.
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As with the graphic dialogs, borders or mini-borders available from the
current library are listed at the left. The currently highlighted border or
mini-border is shown in the display area at the right. (To change libraries,
click on the Change Library button, open the Libraries folder if it's not
already open, and then choose the library you want.)

The size of the border or mini-border can be small or large. Large borders
are wider than small borders. To change the size, click on the Size popup
menu below the list of borders and choose Small or Large.

To apply the selected mini-border to all mini-borders on the project. check
the Apply to All Mini-borders checkbox.

When you are satisfied with your border or mini-border selection, click
OK.

Note: If you are working on a Certificate project, you will see a list
of borders designed especially for certificates. These borders are
large and ornate. The Size popup menu is not available. For more
information on Certificate Borders, see the Certificate.section in
Chapter 5/ The Projects.

HORIZONTAL AND VERTICAL RULED L1NES

Ruled lines are straight-line graphics. They are generally used to separate
sections of a design or to add decorative touches. A varied selection of
ruled lines-some businesslike, some elegant. some whimsical-is
available for your projects.

To fill in a ruled line, simply double-click on its placeholder. The Ruled
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HEADLINES

Une dialog will appear. This dialog works the same as the Graphics and
Border dialogs. The list of available ruled lines is the same for both
horizontal and vertical orientations. The only difference is their
orientation. Ruled lines may be resized in length only (not width).

Headlines are one of the most striking features of The Print Shop Deluxe
Companion. They consist of one or two lines of shaped and styled text
filling the entire text block. Headline text can be shaped, styled, and
colored in a variety of ways to create dramatic, eye-catching headline
effects.

To fill in a headline, double-click on the headline placeholder. The
Headline Text dialog will appear. The Headline Text dialog consists of a
text entry area, a library of styling effects, and popup menus fram wh ich
you can select font, shape, and, if you have two lines of text entered,
justification.

Heodline TeHI

-Effect-

Font: I NewZurico

A ShOlle: r- Retlongulor

Justify: I left

Contel OK

32

Entering h~adline text

Type in text at the cursor in the text entry area. To enter two lines of
text, type in the first line, press Return, and type in the second line.

T0 delete text, position the cursor to the right or left of the t~xt and drag
to highlight it. Press the Backspace or Delete key to delete the
highlighted text. Or if you prefer, position the cursor to the right of the
text and use the Delete key to delete the text one character at a time.

Changing headline text attributes

To change attributes of the headline text, open the menu for the attribute
you want to change and select the setting you want.
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The Font popup menu lets you select a font for your headline. Headlines
in layouts have adefault font already selected, but you can change it if
you prefer. To change the font. click on the Font popup menu, then
choose the font you want fram the list that appears. The capital letter
"A" from the selected font will be displayed in the Effect box at the left
of the screen.

To see all the fonts that come with The Print Shop Deluxe Companion,
see the back cover of The Print Shop Oeluxe Companion Graphics
Reference Booklet. Any other TrueType fonts that you have installed in
your system will also be available.

Shape

The Print Shop Deluxe Companion has many different and exciting
shapes for headlines. To change the shape, click on the Shape popup
menu, and choose the one you want from the list that appears. A small
graphic in the list gives you an idea of how each shape looks. Choose
the one you want. To see how each shape looks without trying them all
out. consult The Print Shop Oeluxe Companion Graphics Reference
Booklet.

Justify

If your headline has two lines of text. the Justify popup menu lets you
change the justification for the shorter of the two lines. The choices are
Left, Center, Right, or Full. If you choose Full, the shorter line will be
sized so that it reaches fram the left to right points of the longer line. If
your headline is only one line, the Justify menu will be grayed out.

Effect

The Print Shop Deluxe Companion lets you create dramatically styled
effects for your headline, such as adding block shadows or color blends.
You can select a styling effect fram a library of twenty-five pre-designed
effects. You can then customize the effect if you want. To select an
effect, click and drag the' scroll bar beneath the Effect display area to
scroll thraugh the Effect library. You can also click once on the arrow
keys beside the scroll bar to move forward and backward slowly until
you find the effect you want.

The very last selection in the Effect library will reflect your most current

33



• • • • • •
settings. This is a custom effect that will remain available until you quit
The Print Shop Deluxe Companion, or until you design a new custom
effect.

Customizing a headline effect

You can customize any of the styling effects in the Effects library. To
customize an effect, click the Customize... button. The Custom Effect
dialog will appear, with the current effect displayed in the preview box to
the right.

[ Contel ) n OK ]1
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Use the Text, Shadow, and Color popup menus in the dialog to apply
customizing effects. When you are done customizing, click OK to return
to the Headline dialog. All the effects you have chosen will appear in the
Effect Preview, and they will be applied to the headline in your
document.

Text Options

Style

The Style menu sets the outlining style of the text. The choices are Plain
(no outline), Thin Outline, Thick Outline, or Highlighted. Highlighted
places a thin outline around the text and a white highlight within the text.

No
Outline
No Outline: No outline around text.



• • • • The Basics

Tip: Remember that you can
change the way the blend looks
by reversing your text and text
~/end choices. For exatnple, if
you have selected aBIend
Across style for your text and
are using the default colors
(black for text, white for text
blend), the text will blend
acrass trom black to white. It
you want it to blend acoss trom
white to black, simply change
the color choices. Make the
text white and the text blend
black.

Black to wh~~®

WMe to black

Thin Outline: Thin outline around text.

Thic~
Outliro®
Thick Outline: Thick outline around text.

H-ghlight
C>utli e

Highlight Thin outline around text; white highlight between the text and
the outline. The highlight will always be white.

Fill

Refers to the way the text is filled in with color. The choices are Solid,
Blend Across, Blend Down, Double Blend, or Radiant Blend.

SOLID STYLE
Solid: No blend (text color)

Blend Across: Blends from left (text color) to right (text blend color)

Blend Down: Blends from top (text color) to bottom (text blend color)
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rop Shadow
L wer Right
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Double Blend: Blends from top and bottom (text color) to middle (text
blend color)

Radiant Blend: Radiates fram center (text blend color) to outer edges
(text color)

Shadow Options

Style

Refers to the type of shadow behind the text: No Shadow, Drop Shadow,
Block Shadow, or Silhouette. Silhouette puts a panel behind the text in
the same shape as the text.

Position

Determines the position of a drop or block shadow. Choose: Upper Left,
Upper Right, Lower Left, or Lower Right.

Fill

Refers to the way a Silhouette shadow is filled in with color. Choose:
Solid, Blend Across, Blend Down, Double Blend, or Radiant Blend.
These are the same fill effects as for text, shown above.

Color

Lets you choose color and shading for various elements of the headline
fill, shadow, and outline, The top popup menu lets you choose the area
you want to color. Areas that do not apply to the current headline will be
grayed out. Once you have chosen the area you want to color, click on
the Color popup menu. Choose the color you want from the color chart
or list that appears. Choose a shading percentage from the last, Of

bottom. popup menu.
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TEXT BLOCKS

For solid text or the first color in text blends.

Text Blend

For the second color in text blends.

Outline

For the text outline.

Shadow

For solid shadows or the first color in silhouette shadow blends

Shadow Blend

For the second color in silhouette shadow blends.

Creating the headline

When the headline is the way you want it, click OK. You will be returned
to the Headline Text dialog. Click OK from this dialog and you will be
returned to the document window. The headline will appear on your
project just as you have designed it.

Text blocks are spaces where text can be entered. The text can be
modified on a character-by-character basis, using different fonts, styles,
sizes and colors. The amount of text you can enter in a block depends on
the text size and the size of the block. The entire block can be resized to
accommodate more text. A text block that is part of a layout has
attributes such as font. size, and style already set. But you can easily
change any text attributes by using the Text menu and the tool palette.

To enter and edit text, simply double-click on the text block placeholder.
The text block will become white with a flashing cursor. Type in text at
the cursor. If you make a typing mistake, use the Backspace key to
delete incorrect characters to the left of the cursor.

When a text block is selected or when you are actively editing or typing
within a text block, the Text menu will become active. You can use the
Text menu to go into the Text Settings dialog change text attributes. Or
you can choose font, style, size, justification, or placement, or set up a
name merge by using Name Merge from the Text menu.
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Text attributes include: font, style of font, justification, placement, size,
and color. The text you type will have the currently selected attributes.

To change attributes for text already entered, simply highlight the text
you want to change and select new attributes for it. In this way
attributes can be given to the text on a character-by-character basis. To

highlight a single letter or portion of text, position the cursor to the left or
right of the text and drag the mouse. To highlight an individual word,
simply double-click on the word.

Fant

The Print Shop Deluxe Companion comes with several TrueType fonts
that will appear in the Fant menu. If you have TrueType fonts from other
sourees, or if you are using Type 1 fonts, they will also appear in the Fant
menu. Choose the font you want to use.

Note: If you are using Type 1 fonts, but you are not using ATM
version 3.0 or a later version, the Type 1 fonts may be poorly
displayed onscreen. However, they should look fine in your
printout.

Important: You will not see The Print Shop Deluxe Companion
fonts if you didn't drag the Font suitcase into the System folder
as described in the installation instructions. Refer to the ReadMe
file or page 10.

Style

You can apply one or more styles to your text. Style choices are: Plain,
Bald, Itaiic, Underline, Outiine, and Shadaw.

Size

Sizes are expressed in points, a standard type measurement (one point

equals 1/72 inch). Choose sizes ranging from extra small to extra large.
The sizes have been defined to work weil with each project type and will

vary from project to project. The actual point size is shown in
parentheses. You can increase or' decrease the size one point at a time

by choosing Smaller or Larger. Or choose Other... and type in any point
size you want. If the number you type is too small or too large for the
project you're working on, you will be given a message with the ra n g e

of sizes you can use.
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Note: Remember that changing the size and fant will only affect
text that is highlighted.

Justification

You can change the justification of all of the text you have entered. To
change the justification, select Justification from the Text menu and
choose the justification you want. Choices are: Left, Center, Right or
Fu/l. If you choose Fu/l, the text will be spaced so that it reaches from the
left to the right margin of the text block. Justification settings apply to
the entire text block, not just selected text.

Placement

Placement allows you to change the vertical position of the text within
the text block. Choices are: Top, Center, Bottom, or Fu/l. If you choose
Fu/l, the lines will be spaced so they reach from the top to the bottom
margin of the text block. Placement will not be rendered until you dick
outside the text block.

Color

You can change the color of the text by using the Color Bar on the tool
palette. If you select a color before you start typing, all the text that you
type will be in that color. To change the color of text that you have
already entered, you must first highlight the text you want to change,
select Text in the Item Selector above the Color Bar and then choose a
color. To choose a color, simply click and hold on the Color Bar and select
a color from the color palette or list that appears. Color is a great way to
make your text look exciting. You can color individual words and phrases,
or even individual letters.

Resizing the text block

If the amount of text you have entered is too large or too small for the
text block and you don't want to change the text size, you can simply
resize the entire block. To resize the block, dick on the Pointer tool on
the tool palette. Then grab one of the handles on the.text block and drag
to resize. When the block is the size you want it to be, release the
mouse button.

Name Merge

The Print Shop Deluxe Companion's Name List feature lets you create
lists of names and addresses that can be automatically added into your
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projects. For example, you can print a group of post cards with a different
name and address on each. Each Name List merge entry can contain up
to five lines. To insert entries from the name list into a text block, double
dick on the text block, then place the insertion cursor where you want to
merge the names. Select Name Merge from the Text menu. Select the
lines you want to merge from the list that appears. Select All Lines to
insert all of the lines.

For complete information on using the Name List feature, see the Name
List section in Chapter 5, The Projects.

Title Blocks (Certificates only)

Title blocks are special text blocks designed specifically for certificates.
They allow you to create a line of headline text and up to two lines of
regular text all at once. This saves time and effort and helps guarantee
that your certificate will be neat and professional-Iooking.

For complete information on title blocks, see the Certificate section in
Chapter 5, The Projects.

Signature Blocks (Certificates only)

Signature blocks provide lines on which people can sign the certificates
you create. The signers' names and/or titles can be printed beneath the
lines. As an added fun feature, The Print Shop Deluxe Companion
includes a list of autographs of famous people that can be printed on the
signature lines.

For complete information on signature blocks, see the Certificate section
in Chapter 5, The Projects.

Seals (Certificates only)

Seals are circular graphic objects that you can combine with one or two
lines of text to decorate your certificates.

For complete information on seals, see the Certificate section in Chapter
5, The Projects.

IMPORTING GRAPHICS

You can import either EPSF or PICT graphics into The Print Shop Deluxe
Companion. To import one of these graphic types into your project, use
the Import command from the File menu. Select the graphic type and
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choose the file you wish to import. The image will be placed in your
document and can then be resized, placed, flipped, framed, rotated in 90
degree increments, and have color added behind it.

There are some special considerations to keep in mind about EPSF
graphics. EPSF stands for 'Encapsulated PostScript File' and, as its name
implies, it contains special instructions for PostScript printers. You
should have a PostScript printer if you plan to work with EPSF graphie
files.

Most EPSF graphics also contain a PICT preview of the image for
onscreen viewing. As long as the EPSF image you are importing has a
PICT preview, the image will be shown in The Print Shop Deluxe
Companion's document window. If the EPSF file does not contain a
PICT preview, then the image cannot be displayed onscreen. Instead, a
box will be placed in the document that represents your imported EPSF
image.

TOOL PALETTE

The tool palette contains nine tools and a Color ContraI Panel. You can
use these tools, as weil as The Print Shop Deluxe Companion menus, to
modify, add to, and edit your design in many different ways. All of your
work will be done in the document window. Your changes will appear as
you make them so you'lI be able to evaluate your design as you go, fine
tuning it until it's exactly the way you want it to be.

Pointer tool

Text tool
New Object tool

Hand tool
Delete tool

View tool

Rotate tool
Frame tool

Flip tool

Item Selector

Color Contral
Panel Color Bar

Tint Slider
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Select a tool by clicking on it. Some of the tools work like conventional
cursor-mode tools that you may be familiar with from other programs.
These include the Pointer, Text, Hand, and Rotate tools. When you select
these tools, the cursor changes. The tool remains active until another
cursor-mode tool is selected. Other tools give you convenient access to
menu commands. These include the New Object, View, Flip, and Frame
tools. When you select any of these tools, a menu appears from which
you can make choices. The Delete tool dele~es selected objects from
your project.

You can use the drag bar at the top of the tool palette to move the tool
palette to a more convenient location on the screen. To make the tool
palette disappear, click the close box in the upper left corner of the
palette or select Hide Tools from the View menu. To make the tool
palette reappear, select Show Tools.

Pointer Tool

a The Pointer tool lets you select, move, and resize objects. To select an
object, click on it. Handles will appear at the corners of the object to
indicate it is selected. To select additional objects, hold down the Shift
key while you click on the additional objects. To move an object, click on
the object and drag it to its new location. To resize an object, drag one of
the handles. If the object is a square, row, or column graphic, aseal, or a
signature block, the aspect ratio of the object will be maintained. To
resize one of these objects without maintaining the aspect ratio, hold
down the Option key as you drag. If the object is a headline, text block,
title block, or mini-border, the reverse is true: holding down the Option
key as you drag maintains the aspect ratio. Ruled lines only stretch
lengthwise, and borders cannot be resized.
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Text Tool

The Text tool lets you create text blocks, enter text, and select text to
edit. T0 create a new text block, position the text cursor where you want
the upper-Ieft corner of the text block to be and drag. You can enter text
immediately in the newly created block. To enter text in an existing
block, double-click the block to change to edit mode and then enter the
text. To select text to edit, position the cursor and drag to highlight the
text you want. Use the Text menu to change the attributes of the
selected text, including font, style, size, justification, and placement. You
can also use the Text menu to select a name merge. Use the Color Bar
on the tool palette to change the color of the text. To deselect text, click



• • • • The Basics

anywhere on the text block. Note that if you are entering or editing text in
a block that has been rotated, the block will return to a horizontal position
while you work on the text. When you are done, the rotation will be
restored automatically. Likewise, if the text block is behind another
object, it will be brought to the front while you work on the text and
restored to its original position when you are done.

New Object T001

The New Object tool lets you add new objects to your project. When you
select this tool, an object menu will appear. The choices for all projects
are: Square Graphie, Row Graphie, Column Graphie, Text Block, Headline,
Horizontal Ruled Une, Vertieal Ruled Une, Mini-border, and Border. If you
are working on a certificate project. the choices will also include:
Signature Block, Seal, and Title Block, and Certifieate Border will replace
Border. Highlight the one you want. A placeholder for the object will
appear on your project in the middle of the page. You can move the
placeholder by clicking on it and dragging, and you can resize it by
clicking and dragging one of its handles. Double-click the placeholder to
select a graphic or enter text. You can also add a new object by selecting
Addfrom the Object menu.

If you hold down the Option key when you select the New Object tool,
the behavior of the tool changes. In this case, when you select an object,
no placeholder appears on the project. Instead, a new object cursor
appears. Drag the cursor to create a piaceholder for the type of object
you selected. Make the placeholder as large or as small as you want.
When you are done, create additional placeholders of the same type by
positioning the cursor and dragging. If you want to create a placeholder
for another type of object, hold down the Option key and select the New
Object tool again and choose the object type you want. Using the New
Object tool in this way allows you to place and size a new object with
one action.

Hand Tool

The Hand tool lets you move your project around within the window if
the project is being viewed at a size that does not fit entirely in the
document window. To use the Hand tool, position the hand on the
project and drag. Using the Hand tool is the same as using the scroll
bars.
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The View tool lets you change your view of the project by zooming in or
out. When you select this tool, a menu will appear. Choose Zoom In or
Zoom Out or one of the specific zoom commands. Fit to Window is the
default. It shows your project at a size that fits in the document window.
Actual Size shows the project at the size it will be when printed out. 25%
is one-quarter actual size. 50% is half actual size. 150% is one and a half
times actual size. 200% is twice actual size. The zoom commands are
available from the View menu as weil.

Delete Tool

The Delete tool lets you delete a selected object. If you change your
mind and want the object back, select Undo from the Edit menu before
taking any new actions. You can also delete objects by selecting Clear
from the Edit menu or by pressing the Delete key.

Rotate Tool

The Rotate tool lets you freely rotate a selected object. T0 perform a free
rotation, click on a corner of the selected object and drag in either a
clockwise or counter-clockwise direction until the object is the way you
want it to be. Rotate additional objects by first clicking the object to
select it and then dragging as before. If you want to rotate an object by a
specific number of degrees you can do so by selecting Rotate from the
Object menu. A dialog will appear in which you can type or select the
specific rotation you want.

Flip Tool

The Flip tool lets you flip a selected graphic object (except for borders,
mini-borders, and seals) horizontally, vertically, or both. When you select
this tool, a menu will appear. Choose: Horizontal, Vertical, or 80th. You
can also flip an object by selecting Flip from the Object menu.

Frame Tool

The Frame tool lets you place a frame around a selected object. When
you select this tool, a menu will appear. The choices are None, Thin Une,
Thick Une, Double Une, or Drop Shadow. The current setting of the
selected object is indicated by a check mark. If a number of objects with
different frame settings are selected, no check mark will appear. You can
also frame an object by selecting Frame from the Object menu.
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MENUS

The Color Control Panel lets you choose colors for various parts of the
design. Select the object you want to color by clicking on it with the

Pointer tool. Click and hold on the Item Selector (the top bar on the
panel) and choose an area to color from the list that appears. The choices
are: Object (ar Text), Behind Object (ar Text), Frame, Backdrop, Page,
and Page Blend. If a signature block is selected, the choices Signature
Text and Autograph will also appear. If no object is currently selected,
then only Page, Page Blend, and Backdrop (if one has been selected) are

available. The current color for the selected item is shown in the Color
Bar. If the object contains more than one color, the color is represented
by three color splashes or the words 'multi-colored' if you're working in a

non-color mode. Although you cannot change the color of a multi-colored
object, you can drag the Tint Slider to change its shading percentage. To
change the color of a monochrome object, click the Color Bar and select

a color from the color palette or the list that appears. Drag the Tint Slider,
which moves in 10% increments, to change the shading percentage of

the object's color.

The Print Shop Deluxe Companion has seven menus, in addition to the

Apple menu, that work in the standard Macintosh way. You pull down a
menu to see its list of commands or items, then select the command or
item you want. Items that are not currently available are grayed-out.
Keyboard command equivalents are shown next to the menu commands.
An ellipsis (three dots) following a menu item indicates that selecting that

item will cause a dialog box with options will appear. An arrow following

a menu item indicates that a submenu will appear.

For more detailed information, see Chapter 6, The Menus.

DESIGN OPERATIONS

You can perform all sorts of design operations on the objects in your

layout using the tools and menus. You can add, move, and delete
objects. You can add shadows, frames, and colors. You can scale and
resize, rotate and flip, duplicate, and change the order and the alignment
of the objects. You'll do all your work in the document window and see
the results of your changes instantly. This allows you to experiment,

trying out this or that until you come up with a design that pleases you.

If you plan to do a lot of tinkering with the design, you may want to save
your project before you begin. That way, if your experimentation leads to
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confusion, you'll be able to get the original project back by using the

Revert to Saved option on the File menu, and start over. For details on
saving your project, see page 57.

Selecting objects

Before performing a design operation, you must select the object or
objects you want to change. You can select one, several, or all of the
objects in the design. The changes you make will apply to whatever

objects are selected.

Selecting a single object

Use the Pointer tool to click on the object. Solid black handles will appear
at each corner of the object. The handles tell you that the object is
selected. To deselect the object, click elsewhere on the design. To move

from one obJect to another from the keyboard, use the Tab key.

Selecting additional objects

Hold down the Shift key as you click each additional object. To deselect
the objects, click elsewhere on the design. To deselect only one of a
group of selected objects, hold down the Shift key while you click on the

object again.

Selecting all of the objects in the design

Choose Seleet All from the Edit menu. To deselect the objects, click

elsewhere on the design. (Seleet All does not affect the current
backdrop.)

ADDING SHADOWS AND FRAMES

You can change the look of the objects in your design without altering
the basic layout, by adding shadows and frames.

Adding Shadows

You can add shadows to square, row, and cblumn graphics. The shadow
falls behind the graphic itself, not behind the graphic box. Note that not
all graphics look good with shadows added. Some already have shadows
as part of their design, others are made up of so many small elements
that a shadow may be confusing. Experiment to see whether a shadow

enhances or detracts from the graphic you've chosen.
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dragging clockwise or counter-c1ockwise until the object is the way you
want it to be. You can rotate additional objects by c1icking on the object
you want to rotate and repeating the rotation procedure. If two or more
objects are selected, freely rotating one will rotate the other(s) in exactly
the same way.

To rotate by a specific number of degrees, choose Rotate from the
Object menu. A list of rotation choices will appear. The choices are: Left
90, Right 90, or Other.... If you choose Other... , a dialog box will appear.

Rotate

( Cancel ) K OK ~

Set the specific rotation you want. You can do this by typing a number in
the degree box or by c1icking the arrows to move the number in the box
up or down, or by dragging the rotation diaI in a clockwise or counter­
clockwise direction. If you drag the dial, the degrees of rotation will be
displayed in the degree box.

Note: A rotated objeet retains its degree of rotation even when
included in a group of objeets that are se/eeted and rotated
together. For examp/e, if an objeet is rotated 30 degrees, then
dese/eeted, and /ater included in a group that is rotated 45
degrees, the objeet in question will have a rotation of 75 degrees
(30 plus 45) rather than the 45 degree rotation of the rest of the
group.

Flipping

All square, row, and column graphics, ruled lines, and imported graphics
can btJ flipped horizontally, vertically, or both. To flip an object, first select
the object(s), then select the Flip tool or choose Flip from the Object
menu. A list of choices will appear: Horizontal, Vertical, or 80th.
Horizontal flips the object horizontally along the vertical axis of the object.
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Vertical flips the object vertically along the horizontal axis of the object.
Both flips the object both horizontally and vertically.

ADDING AND CHANGING COLORS

Adding and changing colors are additional ways you can enhance your
design without altering the basic layout. You can color various areas of
selected objects, as weil as the page and backdrop.

Use the Color Control Panel on the tool palette to add and change colors
for a selected object. First choose the area you want to color, then
choose a color and a shading percentage. The Item Selector shows the
current area, the Color Bar shows the current color, and the Tint Slider
shows the shading value.

To choose an area to color, click on the Item Selector. A list of areas will
appear: Object (or Text), Behind Object (or Text), Frame, Backdrop,
Page, and Page Blend.

Note: If the current area is multi-colored, the Color Bar will show
three splashes of color (or will say "Multi-Colored" if working in
a non-color mode). You cannot change the color of multi-colored
graphics, text, or backdrops, but you can change the shading.

To choose a color for the selected object, click on the Color Bar. A color
palette will appear. If you are working in grayscale, the palette will show
shades of gray. If you are working in black and white mode, a list of color
names, rather than color sampies, will appear. You will see an enlarged
square sampie of the color or pattern selected in addition to the small
palette square. This is done to make viewing your selection easier. Select
the color, grayscale, or color name you want by dragging the highlight
through the palette or list. The selected color, grayscale, or color name
will be shown in the Color Bar.

T0 change the shading percentage of the selected color, drag the Tint
Slider. The bar moves in increments of 10%. The lower the percentage,
the lighter the color.

You can color the entire page using a variety of color blends. To choose a
color blend for the page, select Page Blend from the Project menu and
then choose the type of blend you want. (This option will not be available
if you have already chosen a backdrop.) Choices are: Solid, Blend
Across, Blend Down, Double Blend, Radiant Blend, Diagonal Blend ->,
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and Diagonal Blend <-. Then choose the colors you want for the page
and the page blend fram the Color Control Panel.

Solid:
Blend Across:

Blend Down:

Double Blend:

Radiant Blend:

Diagonal Blend---7:

Diagonal Blend+-:

No blend (page color)
Blends fram left (page color) to right (page
blend color)
Blends from top (page color) to bottom (page
blend color)
Blends from top and bottom (page color) to middle
(page blend color)
Radiates from center (page blend color) to outer
edges (page color)
Blends fram upper left corner (page color) to lower
right corner (page blend color)
Blends fram upper right corner (page color) to lower
left corner (page blend color)

SCALING AND RESIZING OBJECTS

Tip: Use the scale and stretch
options .to make agraphie fi/l

the entire design area. Use
the graphie as a backdrop for

the rest of your design. Or
scale and stretch several
graphics to use as a backdrop

for YOU[ design.
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You can scale and stretch objects and resize text blocks without any loss
of quality. Though their size and shape may change, the graphics and text
will remain as smooth and readable as ever.

Scaling

Scaling lets you change the size of an object without altering its aspect
ratio. Squares remain square, rectangles remain rectangular with the
same ratio of height to width. You can scale any of the objects except
ruled lines and borders.

There are two ways of scaling an object: freely, or by a specific
percentage.

Scaling graphie objects and signature blocks

To freely scale a graphic object or signature block, select the Pointer tool.
Position the Pointer over one of the handles on the selected object and
drag until the object is the size you want it to be.

Scaling text blocks, headlines, title blocks, and mini-borders

To scale text blocks, headlines, and title blocks, hold down the Option
key as you drag the mouse.

To scale either a graphic object or a text object by a specific number of
degrees, choose Scale... fram the Object menu. A dialog box will appear.
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Type in the scaling percentage you want or click the arrows to scale up or
down by increments of 10. The current size of the object is defined as

100%, so to make it twice as large you would type in 200, to make it half
as large, 50, and so on.

Stretching graphie objects

Stretching lets you change the size of an object without maintaining its

aspect ratio. You can stretch the object to make it short and fat or
squeeze it to make it tall and skinny. Headlines, title blocks, seals,
signature blocks, and all graphic objects except borders can be stretched.
In the case of ruled lines, however, stretching only affects the length, not

the width, of the line.

To stretch a graphic object, signature block, or seal, select the Pointer
tool. Position the Pointer over one of the handles of the selected object.
Hold down the Option key and drag to stretch.

To stretch a headline, title block, or text block drag without holding down
the Option key.

Resizing text blocks

Resizing is an important technique when working with text blocks. When
you resize a text block, the size of the block will change but the size of

the text will remain the same. This makes resizing a way to fit all the text
you want into the block without changing the text attributes. To resize a
text block, select the block and then use the Pointer tool to drag one of
the handles of the block.
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ADDING, MOVING, AND DELETING OBJECTS

You don't have to stick to the arrangement of the layout. In fact, you

don't have to select a layout at all. You can create one yourself, or
customize the one you selected, by adding, moving, and deleting objects.

Adding Objects

To add an object, use the New Object tool or choose Add from the
Object menu. A list of objects will appear: Square Graphie, Row Graphie,
Column Graphie, Text Block, Headline, Horizontal Ruled Line, Vertieal
Ruled Line, Mini-border, and Border. If you are working on a certificate
project, the list will also include: Signature, Seal, and Title Block.
Certifieate Border will replace Border. Choose the one you want. A
standard-sized placeholder for the object will appear in the center of the

document window. Use the Pointer to move the placeholder wherever
you want. Scale or resize it to suit your needs.

Note: If you hold down the Option key when you seleet the New
Objeet tool, the behavior of the tool changes in several ways to
give you greater flexibility in adding, positioning, and sizing new
objects. First, no placeholder will appear on the project. Instead,
a new object cursor will appear. Drag the cursor to create a
placeholder. You can make the placeholder as large or as small
as you want. When you are done, create additional placeholders
by positioning the cursor in other locations and dragging. To
create a placeholder for another type of object, you must select
the New Object tool again. If you hold down the Option key as
you do so, you can repeat the above process.

Moving Objects

To move an object, select the Pointer tool. Position the Pointer over the

object and drag.

Deleting Objects

To delete an object, first select the object(s), then click on the Delete tool .

in the tool palette, press the Delete key, or choose Clear from the Edit
menu. The selected object(s) will be deleted.
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Duplicating Objects

You can save time and achieve some interesting effects by duplicating
objects. You can duplicate any object or object placeholder. To dupiicate

an object, choose Duplicate from the Edit menu. A duplicate of the
object will appear, positioned slightly to the lower right of the original
object. Use the Pointer to move the duplicate wherever you want.

CHANGING THE ORDER OF OBJECTS

You can easily change the order of objects in your design, placing one
object in front of or behind another. This means you don't need to plan
out your entire design in advance.

You can change the order by moving a selected object all the way to the
front or all the way to the back of other objects in the design. Or you can

move it forward or backward one layer at a time. Layers are determined
by the order in which objects are added to the design. Each time you add
an object you create a new layer.

To change the order of an object, choose Order from the Object menu.

Select the ordering you want fram the list that appears. The choices are:

Bring Forward
Bring to Front
Send Backward
Send to Back

Moves object forward one layer
Moves object to the topmost layer
Moves object backward one layer
Moves object to bottommost layer

Note: You cannot use the Order command to place anything
behind a backdrop or in front of a border. In the case of a border
you can get around this prohibition by using a mini-border
resized so that it functions as a border. Then you can place
objects in front of it.

LOCKING AND UNLOCKING OBJECTS

You can lock a selected object in place so that it cannot be moved in any
way, unless you unlock it. Once an object is locked it will retain its
position in the design area as weil as its order within the layers of the
design. When an object is locked, it will not move even when the Select
All option is in effect and the other selected objects are moved.
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Locking Objects

To lock a selected object in place, choose Lock from the Object menu.
The handles on the object will change from solid to hollow to indicate
that the object is locked. A locked object cannot be rotated, flipped,
scaled, resized, moved, deleted, or ordered.

Unlocking Objects

To unlock the object, choose Un/ock from the Object menu. The handles
on the object will change from hollow to solid.

AliGNING OBJECTS

You can align two or more selected objects in a variety of ways. Aligning
lets you achieve the exact results you want quickly and easily without
relying on "eyeballing" your design.

To align objects, select the objects you want to align. Then choose
A/ign... from the Object menu. A dialog box will appear. Select the
alignment you want by c1icking on the appropriate symbol. For a precise
description of each alignment option, see Chapter 6, The Menus.

Rlign

~~~

~~[JJ
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CHANGING THE BACKDROP OR LAYOUT

( Cancel ]
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You can change the backdrop or layout of your project any time you

want. When you change the backdrop, the layout elements currently in
place on the project (including all objects 'and object placeholders) will
remain. Only the backdrop will change. When you change the layout, all
the current layout elements (including any objects you may have added

to the originally selected layout) will be discarded.
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Changing the Backdrop

To change the backdrop, select Change Backdrop... from the Project
menu. The Backdrop dialog will appear. (If you are working on the back of
a post card, you will not be able to use a backdrop, and this command
will not be available.l Select the backdrop you want.

Changing the Layout

To change the layout, select Change Layout... from the Project menu.
You will be warned that changing the layout will destroy the current
project and asked if you wish to continue. If you click OK, the Layout

dialog will appear. Select the layout you want.

CHANGING THE VIEW

If you want a different perspective on your work you can change the

view. You can zoom in or out to see things larger or smaller. You can
have your work displayed at a size to fit in the window, at the actual size
it will be when printed out, or at a multiple of that size.

To change the view, select the View tool or open the View menu. A list
of view choices will appear. A check marks the currently selected view.

Choose the one you want. Note that a zoom will be centered on the
currently selected object, or on the center of a group of selected objects.

If no object is selected, the zoom will center on the last area clicked, or if
no area was clicked, then on the center of the document window.

Zoom In
Zoom Out
Fit to Window
25%
50%
Actual Size
150%
200%

Zooms in to the next zoom level
Zooms out to the next zoom level

Shows project sized to fit in the document window
Shows the project at 25% (1/4) actual size
Shows project at 50% (1/2) actual size
Shows project at the actual size

Shows project at 150% actual size
Shows project at 200% (twice) actual size

HIDING THE BACKDROP, PLACEHOLDERS, AND TOOL PALETTE

To get a clearer view of your work, you may want to hide the backdrop,
the placeholders, or the tool palette. The Hide commands are on the

View menu. When you select a Hide command, it will change to a Show
command. Select the Show command when you want to see the hidden
element again.
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Hiding the Backdrop

To hide the backdrap, choose Hide Backdrop fram the View menu. The
backdrop will disappear, leaving the layout in place. Select Show
Backdrop to see the backdrop again. (While hidden backdrops are not
visible on screen, they still print.)

Hiding the Placeholders

To hide the placeholders, choose Hide Placeholders from the View
menu. The placeholders will disappear, leaving the backdrop and
whatever parts of the layout you have filled in, in place. Select Show
Placeholders to see the layout again.

Hiding the Tool Palette

To hide the tool palette, choose Hide Tools from the View menu. The
tool palette will disappear. Select Show Tools to see the tool palette
again.

SAVING YOUR PROJECT

When you are finished designing your project you can save it. Once a
project is saved you can use it again and again, changing the text or other
elements as you wish.

Full Saves and Fast Saves

The Print Shop Deluxe Companion performs two kinds of saves: Full
Saves and Fast Saves. A Full Save saves all the graphic data for the
project within the project file itself. The advantage of a Full Save is that
you can load the saved praject without needing to have the graphics files·
on hand. This is handy if you create a project to give to another Print
Shop Deluxe Companion owner who might not have all of the graphics
that you used in your project. The disadvantage is that it takes up more
raom on the disko A Fast Save, on the other hand, saves only references
to the graphics used. The advantage of a Fast Save is that it takes up less
room on the disko The disadvantage is that you can load a project saved
with a Fast Save only if all of the graphics used in the project are installed
on your computer.
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To ehoose the type of save you want set as the default, seleet

Preferenees fram the File menu. The Preferenees dialog box will appear,
showing the eurrent settings. Seleet the save setting you want to be the
default eaeh time you save.

Note: A file whieh eontains an EPSF graphic object cannot be
saved with the Full Save option. Due to the potential size of the
PostScript code embedded in the EPSF graphie, files which
contain these types of graphics ean only be saved with the Fast
Save setting.

Saving the Project

To save your projeet for the first time, seleet Save fram the File menu. A
Save dialog will appear. Type in a name for the prajeet. The projeet will
be saved in the Print Shop Deluxe folder. If you want to save the prajeet

to a different folder, seleet the folder you want from the list. If you want
to save the prajeet in a different loeation, open the menu above the list
and seleet the loeation you want. When you are ready to save the
prajeet, cliek Save.

161 Print Shop DeluHe ..... 1

<$I tHpodm IQ
D libraries
l) PHlCJldp
l) BtiHlNL
D ReadyMades
<$I 'HlP PHn t Slw!) ndml(~ tüm!)<L u ~

=Hard Disk

Desktop

New LJ )

Saue as: [ Cantel )

,-Iu_n_tit_'e_d 1 ( Saue J
o Full Saue

Note: If you are working with the default Fast Save setting, you
can Full Save the current project by checking the Full Save option
box that appears beneath the project name. Conversely, if you
are working with Full Save as the default, you can turn it off for
the current projeet by unchecking the box. As noted above, this
will not be an option if the file contains an EPSF graphic.
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Using the Save As... Command

You can use the Save As... command to save a previously saved project
under a different name. This is useful if you want to design two or more
vers ions of the same project (for example, a certificate with the same
graphics but with a different title block or message).

The Save As... command also provides a way to save a project in both
Full and Fast save formats. To do this, first save in one format. Then save

again using the Save as... command, changing the name and saving in
the other format by checking the Full Save checkbox in the dialog as
outlined above. You can then move the Full Save version of the project to

another system if you want. You can delete the Full Save version from
your current system to save disk space. The Fast Save version will still
be available so the project won't be lost.

To save a project under a different name, select Save As... from the File
menu. The Save dialog will appear. Type in a new name. Click OK.

Using the Revert to Saved Command

Once you've saved your project. you can continue to work on it. If you're
not satisfied with the changes you make, you can use the Revert to
Saved command to return to the last saved version of the project and
start over.

To return to the last saved version of the project, select Revert to Saved
from the File menu. You will be warned that when you revert to saved
you will lose all the changes you have made to the project. If you are

sure that's what you want to do, click OK. The project will appear in the
document window, exactly as it was when you last saved it.

Note: Ws a good idea to save your project periodically whenever
you've reached a satisfactory point in the design. That way you'lI
return to a desirable point when you use the Revert to Saved
command.

PRINTING YOUR PROJECT

You should check that the printer you are using is currently selected in
the Chooser utility provided with your Macintosh. The Chooser is listed
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under the Apple menu at the top of your screen. For more information
on using the Chooser, please see the Macintosh Reterence manual.

Once you have selected and turned on your printer, you can test it to be
sure it is set up and working correctly. Choose Test Printer trom the File
menu. The selection will print a rectangular frame that shows you where
your project will be placed on the page. Adjustments can be made using
Page Setup... or the print options described below.

Page Setup

Select Page Setup... trom the File menu. The Page Setup dialog varies,
depending on the printer you are using. Choose the settings you want.

Printing

When you are ready to print your project, select Print... from the File
menu. The Print dialog will appear with the currently selected printer
named at the top. The Print dialog varies in appearance and functionality
depending on the printer you are using.

laserWriter "laserWriter IINT" 7.1.2 U Print J
COPies:~ Pages: @ All 0 From: LJ To: LJ [Cancel )

Couer Page: @ No 0 First Page 0 last Page

Paper Source: @ Paper Cassette 0 Manual Feed

Print: @ Black 6' White 0 Color/Grayscale

Destination: @ Printer 0 PostScript® File

Name list [8] All Names ( Select Names 1 (More Options 1

Number of copies

If you want to print more than one copy, highlight the number in the box
and then type in the number of copies you want.
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Name list options are available only if you have used the Name List
feature in any text block on your project. From the Print dialog you can
specify the name list to merge and which names to print. To select a
different list. click the Name List button and choose the list you want. To
print all of the names on the list, make sure the All Names checkbox is
checked. To print only some of the names on the list, click the Select
Names button. The Select Names dialog will appear with the current
name list file name at the top of the dialog. All of the names on the
current list are shown and by default, they are all selected. To select
individual names, click on a name you want to print, then hold down the
Shift key and click on the other names you want to select. To select all
the names, click the Select All button. When you are done, click OK to
return to the Print dialog.

Selett Names for prlnt

Current Name list File: name

Names:

re smeln John
Ceruleri, Frank
Chin, Paula
Edgewood, 88rbara
Holden, Lee
Martinez, Linde

ID
[ Selecl Rli I ~ !C8ncel ) CEJ

More Options

C1icking on the More Options button brings up a dialog containing
further print options. Print Alignment, available for all project types, lets
you move your project in small increments to give you more precise
control over printing. If your project is not placed properlyon the page
when you print it, you can "nudge" it into the correct position by using
this option. Enter a number between 31 and -31 in the Horizontal or
Vertical alignment boxes, or click on the up and down arrows to move
the project slightly up, down, left, or right on the page. Click on the
Revert button to return to the previously saved setting.
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Your project can move as far as your printer's printable area will allow.
When you reach the edge of the printable area, the numbers you enter in
Print Alignment will no longer move your project.

Other print options are specific to the individual projects. For complete
information on other print options available for each project type, see that
project's Printing section in Chapter 5, The Projects.

QUITTING THE PROGRAM

When you are done using The Print Shop Deluxe Companion, quit the
program by selecting Ouit from the File menu. You will be given a chance
to save your work. If you are at the Select a Project dialog, click Cancel.
then choose Ouit from the File menu.
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The Print Shop Deluxe Companion certificates are a great way of
recognizing accomplishment, awarding achievement, or simply letting
someone know they're special. This project makes creating handsome,
official-Iooking certificates quick and easy. Design an individual certificate
for an important person in your life, or use the Name List feature to
produce certificates for everyone on your team, or in your class, club, or
office. A number of ready made certificates are available to make the
task even easier. Use plain paper or special preprinted certificate paper
available fram paper suppliers.

Selecting a Certificate Orientation

Certificates can be created in two orientations: Tall or Wide. Click on
Certificate in the Select a Project dialog and then choose the orientation
you want from the Certificate Orientation dialog. If you want to use a
ready made certificate, click the Ready Made button. Choose the Ready
Made certificate you want from the list that appears.

Ready Made Certificates

Ready made certificates let you produce great-Iooking certificates in no
time at all. Ready mades come completely designed with graphics and
text in place.

If you choose a ready made certificate, you will go directly to the
document window. You will not see the Select a Backdrap or Select a
Layout dialogs described below. At the document window, you can
modify the certificate, choosing different graphics. entering different
text, or adding any objects you want.

Backdrops

Certificates use tiled backdraps. When you are working on a certificate
praject, the only backdraps that will be listed in the Select a Backdrop
dialog are those that are tiled. This is true no matter what backdrop
library you use. Select the tiled backdrop you want from the list. Note
that if you choose Blank Page you will later be able to color the page
with a solid color or page blend. Click OK, then choose a layout fram the
Select a Layout dialog. You will see the program's entire list of certificate
layouts. Lighten the backdrop if you wish.
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Design Elements

All the design elements available for other Print Shop Deluxe Companion

projects are available for certificates. However, the list of borders you will
see is different. In addition, Signature Blocks, Seals, and Title Blocks are

available. These certificate-specific elements appear in the layouts and
can be added to your project by way of the New Object tool or the

Object menu.

Borders

The list of borders you will see when working on a certificate is different

from the list for other projects. Certificate borders are larger and more
ornate than regular Print Shop Deluxe Companion borders. If you want to
use a regular border for your certificate, you can achieve the effect you

want by adding a mini-border and stretching it to fit the page.

Title Blocks

Title blocks are special text blocks designed specifically for certificates.
They allow you to create a line of headline text, called a Title Line, and up
to two lines of regular text, called Secondary Lines, all at once. This
saves you time and effort and helps guarantee that your certificate will

be neat and professional-Iooking.

lilie Block

[~J
lilie Une:

ICertificate I
Secondary Lines:

I~eri~ I
[ Customize ... I Size: 1 Lorge Tille/Small 2nd Une Yl

Font: I Tribune Yl [ Help I
Font: 1 YlDiploma

Color: 1 "'l
Shope: I,.... Yl ( Concel )

Top Rrch
Style: I Ploin "'l I OK J

Tille Une Secondary Une. _

To enter the Title Line, type in the text you want in the text entry area.
Use the Shape popup menu to choose a shape for the Title Line. Choices
are: Reetangular, Are Up, Top Areh, or Squeeze. Use the Fant popup
menu to choose a font. Choose the Customize... button to go to the

Custom Effect dialog. Effects and customization are the same as for

headlines.
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To enter the Secondary Lines, type up to two lines of text in the text
entry area. Use the Font popup menu to choose a font. Use the Style
popup menu to choose between Bold, Italie, Underline, Outline, or
Shadow if you want one or more of those styles for the text. Use the
color bar to choose a color for the text. Use the Size popup menu to

choose the relative sizes of the Title Line and Secondary Lines. When

you are done entering and editing text, click OK.

Signature Blocks

Signature blocks provide signature lines where people can sign the
certificate you create. A signer's name, title, or other information can
appear beneath each signature line. The program also provides
autographs of famous people, such as Abraham Lincoln, that you can

choose to have printed on the signature lines.

The lines in a signature block are arranged in various configurations.
When you add a signature block to your certificate, the Signature

Arrangement dialog will appear. Choose the signature arrangement you
want. Signature lines with that arrangement will appear on your project.
lf you want to add text to the lines, double-click on the signature block.

The Edit Signature dialog will appear.

Edit Signature

TeHt Under Signature: ~Au_t---,og=-r---,ap_h_s: ~

INone "'1
INone "'1

Color: ~I~~!~~"'~I
100"1, "'1

Font: I Tribune

Size: I Medium Large

Justify: I Center

"I ,..-,-,---,----~ r--------,

L[ C::..:h:..:::a~ng~e~A=rr=a=ng~e.:.::m~en;t;;l~(;;;;;H~el~p-----.J(141"'1

... l (Cantel 1 Ir OK B
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The Edit Signature dialog lets you enter and edit text for each of the
signature lines. The text will be printed beneath the lines. You can enter
the name andjor the title of the person who will sign the line or any other

text you want. Type text in the Text fields. Use the color bar below to
choose a color for the text. Use the Font popup menu to choose a font.
Use the Size popup menu to choose a size. Sizes from Extra Small to
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Seals

Extra Large are available. Point sizes are shown in parentheses. To
specify a different size, choose Other... and type in the point size you
want. Use the Justify popup menu to choose a justification. Choices are
Left, Center, Right, Fu/l, or Right/Left. If you choose Full, the text will
stretch from one end of the signature line to the other. Right/Left is
available only for some arrangements. If you choose Right/Left, the text
will be left-justified for the column on the left and right-justified for the
column on the right.

Use the Autographs popup menus to choose autographs for the
signature lines if you want. To leave the area above the signature line
blank, choose None (this is the default). If you choose an autograph
without typing text in the corresponding name box, the program will
automatically insert the name of the autograph you have chosen. Use the
color bar below to choose a color for the autographs.

Note: You can also change the autograph color and the
signature text color from the Color Control Panel on the tool
palette. These choices will appear in the Item Selector if you have
a signature block selected.

To change the arrangement of the lines within the signature block, click
the Change Arrangement button. Select the arrangement you want
fram the Signature Arrangement dialog. You can change the arrangement
at any time. If you choose an arrangement with fewer lines than your
original signature block, you will lose lines, starting from the bottom up.

When you are done entering text and editing the signature block, click
OK.

Note: You do not have to add text to signature lines. If you prefer,
you can simply print the certificate without going into the Edit
Signature dialog. Plain signature lines in the arrangement you
have chosen will be printed on your certificate. If you don't want
signature lines printed, delete the signature block from the
project.

A seal consists of a decorative edge with a center graphie and a line of
text between the graphie and the edge.
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Double-clicking on a seal takes you to the Seal dialog. Select a graphic for
the center of the seal by clicking on the Seal Center... button and
choosing the graphic you want. Select a decorative edge for the seal by
clicking on the Seal Edge... button and choosing the edge you want. The
center and edge you have selected will be shown in the display area. If
you don't like the way they work together. click the appropriate buttons
again to make other choices.

Enter seal text in the Top and Bottom boxes in the Seal dialog. Top text
goes above the center graphic; bottom text goes below the center
graphic. Use the Fant popup menu to choose a font for the text. Click the
Bullets checkbox to place bullets between the top and bottom text. Click
again to remove the bullets. Click the Preview Text button to see a
preview of the text on the seal.

OK ))Help1:81 Bullets [ Prelliew TeHt )

Seal

Seal TeHt: Seleet Graphie:

Top: IEHeellenee in Rehiellernell [seal Center... 1( Seal Ellge...

Bottorn: 1199~ I

Font: I Tribune "'1
Itern: I TeHt "'1
Color: I ... ,

To color either the text or monochrome graphic centers or edges. use
the Item popup menu and select the object you wish to color. All three
pieces of the seal can be colored independently.

When you are done, click OK. The seal will appear on your certificate
exactly as you designed it. You can scale the seal if you want, making it
larger or smaller by dragging one of the handles. You can stretch it by
holding down the Option key as you drag. You can use the Color Contral
Panel on the tool palette to add color to the area behind the seal. Choose
Behind Object from the Item Selector and then choose the color you
want.

Using the Name List for Certificates

The Name List feature makes printing multiple certificates with different
names easy. Names from a name list can be merged into certificates by
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way of a text block. If the layout you have chosen does not include a text

block, add one yourself using the New Object tool or the Object menu.
For details on using the Name List feature, see page 74.

Printing a Certificate

When you are ready to print your certificate, select Print from the File
menu. The Print dialog will appear. Set the number of copies you want
to print If you are merging names, choosea name list and the names

you want to merge. The program will print one certificate for each
selected name on the list

Click OK to print

BUSINESS CARDS

Metro Rea~
Horriet Anderson

Metro Rea~
Noncy Corrington

Metro Rea~
Jerry Stewort

The Print Shop Del~xe Companion business card project lets you design
and print business cards quickly and easily. You can create cards for all
the different hats that you wear in your professional and personaliife.
Print as many or as few as you want whenever you need them. If you

wish, you can use preprinted business card paper available from paper
suppliers. The business card project can also be used to design and print

name tags. Use the Name List feature to merge names for tags or cards
at print time.

Selecting a Business Card Orientation

Business cards can be created in two orientations: Tall or Wide. Click on
Business Card in the Select a Project dialog and then choose the
orientation you want

Choosing a Business Card Backdrop and Layout

Choose any backdrop you want. Note that if you choose Blank Page you

wililater be able to color the page with a solid color or page blend. Select
a layout fram the Select a Layout dialog. The layouts you see are
designed to work weil with the backdrop you selected. To see the
program's complete collection of business card layouts, lighten the
backdrop

Using the Name List for Business Cards

You can insert names from a name list into any text block on a business
card. This is a handy way to use the business card project to design
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name tags, merge printing a different name on every tag. For details on
using the Name List feature, see page 74.

Printing Business Cards

Business cards are printed 10 to a sheet (8 to a sheet on some printers
that require a large "grab area" to feed in the paper). You can print your
cards directly onto card stock or you can print a single copy and then use
a photocopy machine to produce as many additional copies as you need.

When you are ready to print, select Print from the File menu. The Print
dialog will appear. Set the number of copies you want to print. If you are
merging names, choose a name list and the names you want to merge.
The program will print one card for each selected name on the list.

If you are printing on plain paper and would like to have crop marks
printed to guide you when you cut out the business cards, dick on the
More Options button and then dick on the Crop Marks checkbox.
Preprinted business card paper comes with clean-edge perforations so
you don't need to print crop marks. Unprinted white business card paper
with dean-edge perforations is also available.

You can adjust the placement of your printed business cards more
precisely by using the Print Alignment feature, available when you dick
on More Options. For details on using Print Alignment, see Printing your
project section in Chapter 4, the Basics.

When you have set all the specifications you want, dick OK to print your
business cards.

ENVELOPES

Selecting an Envelope Size

Envelopes can be created in two sizes: Print Shop (4 3/8" x 5 3/4") or
Business (4 1/8" x 9"). Click on Envelope in the Select a Project dialog

-- ~=~:... -Ji:

~
~~~1ss

~
~ I').... ··.'ode",",,"Sonw." {
.... 500 Redwood B1vd
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The envelope project lets you design great looking Print Shop Deluxe
Companion envelopes for your personal and business correspondence.
Design one-of-a-kind envelopes or create a variety of designs and save
them for future use. The Return Address feature lets you save your
return address so that it is automatically entered for USPS layouts. The
Name List feature lets you merge print a name list, making it easy to put
out mailings for your business or organization. You can use plain
envelopes or preprinted envelopes available from paper suppliers.
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and then choose the size you want.

Choosing an Envelope Backdrop and Layout

Choose a Print Shop Deluxe Companion backdrop at the Select a

Backdrop dialog. Then choose a layout at the Select a Layout dialog. If
you lighten the backdrop, or if you choose a tiled backdrop or Blank Page,

you will see the program's complete selection of layouts.

Envelope layouts come in two forms: Regular (Hand Delivery) layouts and

USPS (United States Postal Service) layouts.

Regular layouts

Regular layouts include placeholders for various kinds of text and
graphics, but do not necessarily conform to U.S. Postal Service
requirements for the placement of address and return address.

USPS layouts

USPS layouts conform to U.S. Postal Service requirements for placement
of the address and return address. USPS layouts are identified by the

initials USPS before the layout name.

In a USPS layout, the placeholder for the return address cannot be
moved. Experiment with various USPS layouts until you find one that
works weil with your envelope design. The arrangement of each USPS
layout is somewhat different, but all conform to U.S. Postal Service

requirements.

Adding Vour Return Address

You can use the Return Address feature to add your return address
quickly and easily to any envelope you create using a USPS layout.

Enter or edit your return address by selecting Return Address from the
Goodies menu and typing new information in the Edit Your Return
Address dialog. From then on, your return address will appear
automatically in any USPS layout you select.

You can change your return address temporarily for the project you are
currently designing by double-c1icking on the return address and directly

entering the information you want. Your changes will be shown on the
current project, but will not permanently affect your return address
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information, which can be changed only by using the Goodies menu as

outlined above.

3. Fold in left and right
edges, along the lines.

2. Turn the envelope address
side down on the table.

1. Cut out the envelope carefully along
the outer edges.

To print onto a Print Shop envelope, click on More Options and make

sure the radio buttons that correspond to the way your printer feeds
envelopes are correct. To print a Cut Out Envelope, click on More
Options and click on the Cut Out Marks checkbox.

Cut Out Envelope

If you are creating a Print Shop (A2) size envelope, you have an option at

print time of printing directly onto an envelope, or selecting Cut Out
Marks. This option prints the envelope on a regular sheet of paper, with

an outline showing where to cut out the flaps. You then fold and glue the
envelope (refer to the diagram). This is a useful option if you have a

printer that does not handle this size envelope.

Printing Envelopes

When you are ready to print, select Print fram the File menu. The Print

dialog will appear. Set the number of copies you want. If you are merging
names, choose a name list and the names you want to merge. The
program will print one envelope for each selected name on the list.

Using the Name List for Envelopes

You can merge an entire name list, or just those names and addresses

you select. For details on using the Name List feature, see page 74.

Note: Two options in the
More Options dialog let you
speeify how envelopes are fed
into your printer and how the
printed image is positioned.
From the Print dialog, cliek
More Options. In the box on
the lower left, you'll see
ehoiees for Left, Right,
Center, and Wide (you ean
also seleet aerogram printing
here). You ean usually
determine whieh seleetion is
eorreet for your printer just by
looking at the paper guides on
the printer itself; if it's not
obvious, refer to your printer
manual.
The box on the lower right
eontains the ehoiees "Top"
and "Bottom. " For most
printers that feed envelopes
Wide, Top will work best.
Onee you've seleeted Top or
Bottom, try printing a single
envelope; if a large part of the
image does not print, try the
other setting.
The settings you seleet will be
the same whenever you use
the program until you ehange
them. You should always set
envelope feed and position
here instead of in the Page
Setup dialog.

5. Glue flap where it overlaps
the left and right edges.

6. Insert card and tape down top
flap. Put starnp on and mail.
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Aerogram

If you are creating a Business (#10) size envelope, you will have the
option at print time of printing directly onto an envelope, or selecting

Aerogram. The Aerogram prints your envelope design in the middle third
of a sheet of paper. You can then print a message on the other side (for
example, using the Letterhead option of The Print Shop Deluxe). or hand
write a message, then fold your paper in thirds.

To print an Aerogram, click on More Options and then click on the
Aerogram checkbox.

When you have set all the specifications you want, click OK to print.

Feed envelopes into your printer, following printer instructions.

POSTCARDS

Tip: Some printers that feed
envelopes Wide cannot print
to the right edge of envelope,
and the image will not look
centered. If that is the case
with your printer, use an
envelope without a border for
best results.
Note: Some Wide feed
printers have a large "grab"
area required for paper feed
and only a small portion of the
image may be printed. If this
happens, choose Manual from
the Paper Source option in the
Print dialog.

The Print Shop Deluxe Companion post cards have many uses. They're

ideal for quick correspondence and informal invitations. Or use them in
your business or organization for direct mail response cards,
announcements, or reminders. As with envelopes, you can use the
Name List feature to merge print a name list and the Return Address
feature to add areturn address to layouts that meet U.S. Postal Service

requirements. Choose an attractive Print Shop Deluxe Companion
backdrop for the front of the card or use preprinted post card paper
available from paper suppliers.

Selecting a Post Card Orientation

The Print Shop Deluxe Companion post cards are 4 1/4" x 5 1/2". They

can be created in two orientations: Tall or Wide. The back of the post
card, which holds the address, will always be wide even if you choose a
tall orientation. Click on Post Card in the Select a Project dialog and then
choose the orientation you want.

loltrA Schill'R
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Designing a Post Card

A Print Shop Deluxe Companion post card has two sides: Front and Back.
The first steps in designing a post card are choosing a backdrop and
layout for the front of the card. Once you have done so, you will reach

the document window. From there you can proceed to fill in the layout
for the front of the card, or you can use the Project menu or the

Navigation tool at the lower-Ieft corner of the screen to move to the back
of the card. The first time you move to the back of the card, you will pass
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through the layout dialog where you have the option of selecting a
layout.

Front of the Post Card

Choose a backdrop für the front of the post card at the Select a Backdrop
dialog. Choose a layout at the Select a Layout dialog. You will see layouts
designed to work weil with the backdrop you selected. To see a
complete list of layouts, lighten the backdrop or choose a tiled backdrop.

Back of the Post Card

Backdrops are not available for the back of the post card. This area is
reserved for a message, the address, and other mailing information. As
with envelopes, two kinds of layouts are available: Regular (hand­
delivery) layouts and USPS (United States Postal Service) layouts.

Regular layouts

Regular layouts include placeholders for various kinds of text and
graphics, but do not conform to U.S. Postal Service requirements for the
placement of address and return address.

USPS layouts

USPS layouts conform to U.S. Postal Service requirements for
placement of the address and return address. USPS layouts are
identified by the initials USPS before the layout name.

In a USPS layout, the placeholder for the return address cannot be
moved. The arrangement of each USPS layout is somewhat different,
but all conform to U.S. Postal Service requirements.

Adding Your Return Address

You can use the Return Address feature to add your return address
quickly and easily to any post cards you create using a USPS layout.

You can enter your return address any time you want, by selecting
Return Address from the Goodies menu and typing new information in
the Edit Your Return Address dialog. From then on, your return address
will appear automatically in any USPS layout you select.

You can change your return address temporarily for the project you are
currently designing by double-c1icking on the return address and directly
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entering the information you want. Your changes will be shown on the
current project, but will not permanently affect your return address
information (which can be changed only by using the Goodies menu as
outlined above).

Edit Your Return Rddress

First Name last Name

Ipoul I IHarding I [ Cancel]

Rddress 1

I [ Help 111700 Uirginio St.

Rddress 2 II[ OK D

City I Westin I Stote~ Zip 104733 I

Using the Name List for Post Cards

Using the Name List feature makes addressing post cards for large or
small mailings easy. You can merge an entire name list, or only those
names and addresses you select. For details on using the Name List
feature, see page 74.

Printing Post Cards

When you print post cards, you need to run your paper through the
printer twice-once for the front of the card and once for the back. Post
cards are generally printed four to a page. Some post card papers
available on the market print two to a page. The Print Shop Deluxe
Companion accommodates these papers as weil. The size of the post
card remains the same (4 1/4" x 5 1/2").

When you are ready to print, select Print... from the File menu. The
Print dialog will appear. Set the number of copies you want to print. If
you are merging names, choose a name list by clicking on the Name List
button and selecting the list you want to merge. You can select individual
names to merge by clicking on the Select Names button and choosing
those you want. The program will print one card for every name, or
selected name, on the list.

Click Front or Back to specify which side of the post card you want to
print. Print the front of the card, then click the button for back, feed the
printout back into the printer, and print the back of the card. You may
want to experiment with plain paper if you're not sure which direction to
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NAME LIST

feed the paper into your printer for two-sided printing.

If you are printing on plain paper and would like to have crop marks
printed to guide you when you cut out the post cards, click on the More
Options button and then click the Crop Marks checkbox. Preprinted
post card paper comes with clean-edge perforations so you don't need to
print crop marks. Unprinted white post card paper with clean-edge

perforations is also available fram paper suppliers.

Click on the radio button next to the position that applies to the type of

paper you are using. If you are using preperforated post card paper, click
either the Preperfed: 4 Per Page or the Preperfed: 2 Per Page radio
button, depending on the kind of paper you are using. If you are using

regular paper, click the Plain Paper radio button, and choose Crop
Marks, to print four post cards onto plain paper fram either a sheet fed
or dot matrix printer.

When you have set all the specifications you want, click OK to print your
post cards on the side selected. When printing is complete, select Print
from the File menu again. Then repeat the print process, selecting the
other side of the card.

The Name List is a useful feature of The Print Shop Deluxe Companion. It
lets you create lists containing name, address, and other information that
you can merge into your projects. This is perfect for certificates,

announcements, mailings, and name tags. You can create as many name
lists as you want to use for all your personal, organizational, and business
needs.

Using the Name List feature is a three step pracess:

1. You create a name list by entering name, address, and other

information in a dialog.

2. When you are working on a project, you use a text block to set up a
name merge.

3. At print time, you select the names you want to merge.
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Rddress 1

Creating and Editing a Name List

To create a name list, click on Name List in the Select a Project dialog.

Or select Name List from the Goodies menu. The Name List dialog will
appear.

Edit Your Name list
Neme list Entry

rFi::..:rs.:...:tN.:..::o:.:.::me=--- ---, ,::-:lO:.:.:'t:.:.:N-=.om::.:;e ----,

"--- -----.JII 1~
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Ln-dd-re-"--=2--------------.J CED
~_;::::=====;-:--~::::::;~_;:::===:I (Soue 0']
CIty LI ---'I Slotec=J 2ip c==J
Other ( Oelete Record ~

I [reete New Record I~

At the top of the dialog is apopup menu. It displays the first Name List
Entry in the current name list. If this is the first time you are using the
Name List feature, the popup will be blank since you have not yet

created a name list. In the center of the dialog are boxes to enter
information for the five lines of a name list entry. Information for the

current name list entry, if any, will appear in the boxes. At the bottom of
the dialog are two buttons: Create New Record starts a new record;
Delete Record deletes the record currently displayed. To the right are
buttons you click to start a New name list. to Open a name list. to Save
a name list, and to save a name list under a different name (Save As).

When you have completed entering information into the Name List
dialog, select Done.

Creating a Name List

1. Type name list information in the appropriate boxes. Click to place the

cursor in the box you want to use. Press the Tab key to move from one
box to another.

2. When you have entered all your information, click the Create New
Record button to place this record in the name list you are creating and
bring up another blank form where you can add the next record.

3. Continue entering information and adding entries to the name list as
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Note: The maximum
number of records in a
name list file is 200.
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outlined above. To see the name list you are creating, c1ick on the Name
List Entry popup. Your entries will be listed in alphabetical order, sorted
by last name. To delete an entry, select it, then c1ick the Delete Record
button.

4. When you are done adding names, c1ick the Save button to save the
name list you have created. Type a filename in the Save a Name List File
dialog that appears. Then c1ick OK. (This dialog will only appear the first
time you save a name list file. From then on, when you c1ick Save, it will
update the name list file automatically. If you wish to save the name list
file with a different file name, c1ick Save As.)

Creating Additional Name Lists

You can have as many name lists as you want. You may want to maintain
separate lists for your business and personaliife, or for various clubs and
organizations. You can create a new list from scratch by c1icking the New
button and then following the pracedure outlined above. If you want to
create an additional name list that includes many of the same names as
the current list, you can save time by using the Save As command.
Simply c1ick the Save As button and then use the dialog that appears to
save the current list under a new name. Add or delete names fram the
new list until it is the way you want it to be.

Editing a Name List

Once you have created a name list, you can add and delete names or
change name and address information whenever you want. To edit a
name list, select Name List from the Select a Project dialog or the
Goodies menu. The Name List dialog will appear.

To add a name to the current name list, follow the pracedure outlined
above. (Note: To place the currently displayed entry in the name list, c1ick
Create New Record, which places the record you were working on in

. the name list and brings up a new blank record where you can add the
next name and address.)

To edit or delete a name on the current name list, c1ick on the Name List
Entry popup at the top of the dialog and select the name you want. The
name will appear at the top of the Name List Entry popup box; name and
address information will appear below. To delete the name, c1ick the
Delete Record button. To change information for the entry, highlight the
words or numbers you want to change and type in the new information.
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To edit a different name list, dick the Open button. Choose the name list
you want fram the Open a Name List File dialog.

When you are done editing a name list, dick the Save button to save the
edited name list and dick Done to return to your project.

Opening a Name List created in another application

The Print Shop Deluxe Companion Name List feature allows you to open
name lists created in other applications as long as they are saved as Tab
delimited ASCII files and use the record structure described below.

There are eight fields per record; the order of the fields mustmatch the
following order, and not exceed the maximum number of characters per
field:

First Name 20
Last Name 20
Address 1 60
Address 2 60
City 20
State 2
Zip 10
Other 60

The fields within each record must be separated by a Tab character, and
each record must be separated bya hard carriage return (~).

Using The Print Shop Deluxe Companion Name Lists in other
applications

The Print Shop Deluxe Companion saves name list files as Tab delimited
ASCII files, with a tab character separating each field within arecord, and
a hard carriage return (~) separating each record. This is a very common
file format which many database and file manager pragrams will be able
to read.

Setting up a Name Merge

You can merge lines fram a name list into any text block on a project. To
set up a name merge, dick in the text block you want to use to make it
active. Enter whatever text you want in the text block. When you are
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ready to merge lines from the name list, go to the Text menu and select
Name Merge. Select the line(s) you want to merge from the list that
appears. To merge all the lines, select All Lines. While you are editing
the text block, the lines you merge will be represented by the words

<Line 1>, <Line 2>, etc. When you click outside the text block, the first
entry in the current name list will appear in piace of the merged lines.

You can add text before, after, or between the merged lines. However,
the merged lines will always be printed as separate lines. Edit and apply
whatever styling options you want to the text, including the merged
lines. For details on editing text in a text block, see page 37.

Selecting Names to Print

At print time, you'll select the names you want to print for the name
merge. When you're ready to print your project, select Print from the File
menu. The Print dialog will appear.

Click the Name List button to verify that the selected list is the one you
want. To select a different name list, select the name list file you want
and click Open.

The program will print all of the names on the current name list unless
you specify otherwise. To print only some of the names on the list, click
the Select Names button. A list of names on the current name list will

appear. By default all names will be selected. To select or deselect an
individual name, just hold down the Shift key and click on it. To select
multiple names hold down the Shift key and click on the names you
want. To select all of the names on the list, click the Select All button.

When you are done selecting names from the list, click OK. You will be
returned to the Print dialog. Make whatever other print choices you want.

When you're ready to print, click OK. Your project will be printed with the
name entries you selected inserted in the text block.

If any of the name list entries contain text that is too long to fit in the text

block, the program will skip these names at print time, and generate a list
(after printing of the other names is completed) showing you which
names were skipped. You can then adjust the size of the text block in

your project, or change the font size, and print again, selecting just those
names that were skipped.

RETURN ADDRESS

You can enter your return address any time you want, by selecting

Return Address from the Goodies menu and typing new information in
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the Edit Your Return Address dialog. Fram then on, your return address

will appear automatieally in any USPS layout you seleet.

SMART GRAPHICS

The Smart Graphie feature lets you ereate eustom square graphies to use

in your projeets. There are three types of Smart Graphies Initial Caps,
Numbers, and Timepieees. You ean use Initial Caps as lead eharaeters for
paragraphs of text or as monograms. Smart Graphie Numbers are ideal
for announeements and award eertifieates. Timepieees are perfeet for

any eommunieation where you want agraphie representation of time; for
example, the time a party starts, or your business hours. Save the smart
graphies you design in your own Smart Graphie library so they'll be

available whenever you need them.

To ehoose a smart graphie prajeet, cliek on Smart Graphie in the Seleet
a Projeet dialog or, from the doeument window, seleet Smart Graphie
fram the Goodies menu. Choose the smart graphie projeet you want.

Choiees are: Initial Caps, Numbers, and Timepieees.

Designing an Initial Cap

Use the Initial Caps dialog to design deeorative letters to use in your
prajects. You ean design upper- or lower-case initial caps for all 26 letters

of the alphabet.
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Initial Ca ps

Preview

[ Seiet I Graph't ... )
feHt ·1

·1
1BB':b ·1

TeHt
Letter:[!J

Font:lr=='----:7Ne-w-=-zu-rjc-ta-=... '

stYle:~1~~Pl""ai""n=",,·:::1
Sh8pe:e Rectangular .,

Shadow

style:1 No Shodow ·l
Position:! ....... low'e;:-Ri9'h-t'-'-~ "';;'1

Color

The left side of the dialog lets you type in the letter you want to design
and make styling ehoiees for the following: font. text style and shape;
shadow style and position; and color for each area of the letter. The
letter you are designing appears within a square graphie box in the
Graphie Preview at the right side of the dialog. The Seleet Graphie...
button below the preview area lets you seleet agraphie to go behind the
letter.

Making styling choices

Text

Letter
Type in the letter you want to design. You ean type an upper-ease or
lower-ease letter. The letter will appear in the Graphie Preview.

Fant
Choose a font from the Fant popup menu.

Style
Choose a text style from the popup menu. Choiees are: Plain, Thin
Outline, Thick Outline, and Highlighted.

Shape
Choose a shape fram the Shape popup menu.

Shadow

Style
Choose a shadow style fram the popup menu. Choiees are: No Shadow,
Drop Shadow, and Silhouette.
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Note:' If you use Fast Save to

sa\le a projeet, and then
change the name of agraphie

that is:ineluded in that projeet,
the next time you opef]i~e

projeet you will see a messagf7

statinfl thala graphie cannot bf7j
found Just cliek OK in the
meSSq9fA dialog, double:d'ek
on the "'empty p/aeefiold€H in

your projeet, and use the
graphie,selection dialog'to add

the graphie withtQf7; changed·.
name,

Position

If you have ehosen a drop shadow, ehoose a shadow position from the
popup menu. Choiees are: Upper Right, Upper Left, Lower Right, and
Lower Left.

Color

Use the Text popup menu to ehoose an area of the letter to eolor.
Choiees are: Text, Outline, and Shadow. Use the eolor bar to ehoose a
eolor for the seleeted area. Use the Shading popup menu to ehange the
shading of the seleeted eolor.

Selecting agraphie

Cliek the Seleet Graphie... button below the preview area to ehoose a
graphie for the initial eap. Make your seleetion from the Seleet an Initial
Caps Graphie dialog. The graphies listed are designed espeeially for smart
graphies. Highlight the graphie you want and cliek OK. The graphie will
appear behind the letter in the graphie preview area.

Moving, sealing, and stretching the letter

You ean move and streteh the letter just as you would any square
graphie. This allows you to adjust the letter so it fits with the graphie
behind it.

To move the letter, position the pointer over it, cliek and drag. Tostreteh
the letter, cliek on one of the handles and drag.

The graphie behind the letter eannot be moved, sealed, or stretehed.
However, onee it is in plaee on your projeet the entire smart graphie ean
be manipulated just like any other square graphie.

Saving

When you are done designing your initial eap, cliek the Save button to
save it. The Save dialog eomes up allowing you to save your initial eap in
the usual way. The default library for smart graphies is ealled User
Squares 1 and is in the Libraries folder. If you want to save your initial
eap to a different library, cliek on the Change Library button. You ean
also use the New Library button to ereate a new library. You ean
ehange the graphie name by making sure it is seleeted and typing the
new name into the Graphie Name box. When you are ready to save, cliek
on the Save button.
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Onee a smart graphie has been saved, you ean use it whenever you want
by seleeting it fram the Square Graphie dialog. Seleet the library in whieh
the smart graphie is stored and then seleet the graphie you want from

the list that appears.

Saue Graphie

Library: User Squares 1

Caneel

n Saue B

[Change Library]
Graphie Name

I_In_il_C_ap_l 1 ( New Library ]

Preuiew

~l

~l

~
~l

~l

~I

Number Maker

TeHt ~l [Select Graphie ... )

~l

No Shadow

lower Right

Style:1
:="""""',;"";";,;,;;,;,,,,,,~

position:1
'----~_.....

Color

TeHt

Number:D ISI SuffiH

Font:1 New2urica

Style: I Plain

Shape:l_ Rectangular

Shadow

Designing a Number

Use the Number Maker dialog to design a deeorative number to use in
your projeets. Designing a number is just like designing an initial eap
exeept that you are working with a number rather than a letter.

Type in the number you want. Three digit numbers are the largest you
ean use. If you want to add a suffix (st, nd, or th) to the number, cliek the

Suffix eheekbox. The program will add the eorreet suffix to the number.
To delete the suffix, cliek the eheekbox again. Proeeed to design your
number just as you would an initial eap. When the number is the way you
want it to be, cliek the Save button to save it. You ean save numbers in

the same file as your initial eaps, or you ean ereate a separate file just for
numbers.
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UTILITIES

Designing a Timepiece

Use the Timepieces dialog to design a timepiece graphie to use in your
projects. The timepiece can have an analog clock face or a digital read­

out.

The left side of the dialog lets you select a timepiece graphie. The right

side of the dialog lets you enter a time and displays the timepiece with
the time you have chosen. Some timepieces have an analog clock face;
others have a digital read-out.

Timepieces

Library: PSOC Timepieces

Bomber Clock ~

Burden ~.

Cat CIOCkj!i!!:
Cuckoo Clock 1111:::

~:~~t:~~atch t!lil,i

~~~;;;:Oy il'~;

~~~:~~ ~~~ BOH ~
Jam Bab!! -Go r.:;l In;;-]

Time: ~:~

[ Change Library ... 1( Help lH Saue 1) ['-o-o-ne-'

Select a timepiece from the list.

To enter a time, highlight the Time boxes and type in the hour and
minutes you want.

When you are satisfied with your timepiece graphie, click the Save
button to save it.

The Print Shop Deluxe Companion has utilities that allow you to create
your own borders, to merge libraries, and to edit libraries. Borders you
create can be saved and used in your projects. The Merge Library utility
lets you merge two or more libraries into one new user-created library.

The Modify Library utility lets you edit a user-created library, renaming or
deleting any graphics you want.

To use the utilities, click on Utilities in the Select a Project dialog, or
from the document window, select Utilities from the Goodies menu.
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Choose the utility you want. Choices are: Make a Border, Merge Library, and Modify
Library.

Make a Border

The Make a Border utility lets you create a border to be used either as a border or
mini-border in your projects, or a certificate border for use just in the certificate
project. The border is made up of square graphics which you select from any Print
Shop Deluxe Companion or Print Shop Deluxe graphics library. The graphics can be
combined in the border in various ways, making the possibilities for original border
designs nearly endless.

Choosing a Border Type

There are two types of borders: Regular and Certificate. Certificate borders are wider
than regular borders and have fewer arrangement choices. Other than that, the
borders are created in exactly the same way. Choose the type of border you want to
create from the Border Type dialog which appears when you select the Make a
Border utility. The Make a Border dialog will appear.

Creating a Border

Use the Make a Border dialog to create your border. The border will be displayed as
you create it on the right side of the dialog.

Moke R Border

Border Rrrangement

I Single Piece Repeoling ... \

Graphie:

[ Border Piece I •
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Selecting a border arrangement

Use the Border Arrangement popup menu at the top left of the dialog to
select an arrangement for your border. For regular borders, the choices

are: Single Piece Repeating, Corners and Rails, Alternating Rails, and
Rails with Centerpieces. For eertifieate borders, only the first two ehoiees
are available.

Single Piece Repeating
Repeats the same graphie for the entire border.

Corners and Rails
Lets you ehoose agraphie for the corners, agraphie for the

top/bottom rails, and agraphie for the side rails.

Alternating Rails
Lets you ehoose agraphie for the corners, alternating graphies for
the top/bottom rails, and alternating graphies for the side rails.

Rails with Centerpieces
Lets you ehoose agraphie for the corners, agraphie for the center
of the top/bottom rails, agraphie for the rest of the top/bottom rails,

agraphie for the center of the side rails, and agraphie for the rest
of the side rails.

Selecting graphics

Use the Graphie buttons to seleet graphies for the various parts of the

border. When you cliek a Graphie button, the Seleet a Border Graphie
dialog will appear. This dialog works like other graphie seleetion dialogs in

the program. Seleet the graphie you want. Then cliek OK. The graphie
you have chosen will be displayed in the Make a Border dialog. Continue

.seleeting graphies for all the parts of your border.
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APPLE MENU

The Print Shop Deluxe Companion menus contain three types of
selections:

• Plain item names represent commands that will be carried out
when you select them.

• Item names followed by ellipsis (..) indicate that a dialog box or a
list of items will appear. Make choices in the dialog box or select

the item you want from the list.
• Item names followed by a triangle (» indicate that a submenu will

appear. Select the item you want from the submenu.

Some commands are toggles that you can turn on and off. For example,
when you select Hide Tools, the item will toggle to Show Tools.
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About...

Brings up a dialog that will tell you about The Print Shop Deluxe
Companion, including what version you are using. Within the dialog is a
Credits button wh ich you can click to see the names of some of the
people who have worked to make the program pqssible.

Help

Brings up The Print Shop Deluxe Companion Help File.

FILE MENU

New (3€-NI

Lets you start a new project. You will be returned to the Select a Project
dialog to choose the type of project you want. If you have made any

changes to the current project, you will be given a chance to save your
work.

Open. .. (3€-OI

Lets you open a saved project. Choose the project you want from the list
in the dialog box. If you have made any changes to the current project,
you will be given a chance to save your work.
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Lets you close the current project. If you have made changes to the
current project, you will be given a chance to save your work.

Import...I3€\)

Lets you import graphics into your Print Shop Deluxe Companion project.
Choose between either an EPSF or PICT graphic file type and then select

the particular file you want to import.

Save 13€-Sl

Lets you save the current project. The first time you save the project the
Save dialog will appear, allowing you to name the project. The project will
be saved in The Print Shop Deluxe folder, unless you indicate that you

want to save it elsewhere. If you specify a different folder for your
projects to be saved in, that will be the default folder from then on. You
can also turn the Full Save mode on or off. For details on Full Save and
Fast Save, see 'Preferences' below.

Save As...

Lets you save your work under another name. You can also turn the Full
Save mode on or off.

Revert to Saved

Returns you to the last saved version of your project. This is useful if you
have made changes to the project. but decide that you like the original
version better. Any changes you have made will be discarded so you can

start over. For this reason, it's a good idea to save your project
periodically when you are satisfied with the work done to that point.
Then, if you need to use the Revert to Saved command, your project will
revert to the last satisfactory point of progress.

Preferences. ..

Lets you set preferences (defaults) that The Print Shop Deluxe
Companion will use whenever you start the program. Make selections in
the Preferences dialog that appears. The preferences you set will remain

in effect until you change them. The preferences you can set are:
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Save

Choose Fast Save or Full Save. A Fast Save saves only references
to the graphics used. This means that to use a Fast Saved project,
the computer must have all the graphics that appear in the project
installed. A Full Save saves all the graphic data for a project within
the project itself. A Full Save takes up more room, but allows you
to load the saved project onto another system which has The Print
Shop Deluxe Companion program, but not all of the graphics used
in the project. The default is the Fast Save. Note that if you want
to use Fast Save for a particular project, you can change the mode
temporarily, in the Save dialog, and then change it back when you
save subsequent projects.

Font

Choose adefault font. This font will be used for headlines and text
blocks where the font is not set by the layout.

Skip Optional Opening Dialogs

Check this box to bypass the Select a Backdrop and Select a
Layout dialogs. The next time you create a new project. you will
select the type and orientation of the project and then go directly to
the document window to add your own design elements.

Page Setup. ..

Lets you set up your page for printing. Choose the settings you want.

Test Printer ll}€-Y}

Lets you print a frame representing your project's placement on the
printed page. This can save paper and ink and quickly indicate any
adjustments you may want to make to your printer and print settings.

Print. .. ll}€-P}

Lets you print your project. Most of the print options will depend on the
printer that 'is selected. The following options are available for printing a
Print Shop Deluxe Companion project:
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EDITMENU

Lets you choose a name list for merge printing.

All Names

An "X" in this checkbox indicates that all names in the
selected name list are to be used in merge printing.

Select Names

Lets you select one or more names in the name list to use
in merge printing.

More Options

These options vary depending on the project you want to
print. For complete details on the print options available
in the More Options dialog for each project. see Chapter
5, The Projects.

Quit (3€-QI
Lets you exit the program. You will be given a chance to save your work
before quitting.

Undo (3€-ZI

Reverses your last action.

Cut (3€-XI

Cuts a selected object from the project and piaces it on the Clipboard.

Copy (3€-CI

Copies a selected object to the Clipboard.

Paste (3€-VI

Pastes the contents of the Clipboard to the project. Contents will be
pasted in the center of the document window.
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Clears the selected object(s) from the project. The Delete tool performs

the same function.

Duplicate (aß-DI

Duplicates the selected object. The duplicate will appear slightly to the
lower right of the original. Use the Pointer tool to move the duplicate
wherever you want.

Select All (aß-AI

Selects every object on your project including placeholders. To deselect
all, click anywhere on the project. or shift-click on an individual object to
deselect it only. When you're working with text, Seleet All will select all

the text.

OBJECT MENU

Add

Lets you add objects to your project. The objects you can add are: Square
Graphic, Row Graphic, Column Graphic, Text Block, Headline, Horizontal
Ruled Line, Vertical Ruled Line, Mini-border, and Border. For Certificate

projects you can also add: Title Blocks, Signature Blocks, and Seals. In
Certificate projects, Certificate Border will replace Border.

When you add an object, a standard-size placeholder for the object will

appear in the center of the document window. Use the Pointer tool to
resize it and to move it wherever you want. Double-click on the

placeholder to select a graphic or to enter text. You can also use the
New Object tool to add an object to your project.

Edit Object... (aß-JI

Brings up the appropriate dialog to edit the currently selected graphic or

text object.

Shadow

Lets you place a shadow behind the selected graphic(s). The shadow will
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fall behind the graphic itself, not behind the graphic box. Choose On to
place a shadow behind the graphic. Choose Off to remove the shadow.

Frame

Lets you piace a frame around the selected object(s). You can piace a
frame around any object except a mini-border, a border, a ruled line, a
signature block, or aseal. Choose None, Thin Une, Thick Une, Double
Une, or Drop Shadow. You can also use the Frame tool on the tool
palette to place a frame around an object.

Order

Lets you move the selected object(s) forward or backward through the
layers of the project. Layers are established as objects are added. The
backdrop is always the bottommost layer and the border is always the

topmost layer. You cannot move anything behind a backdrop or in front

of a border.

. Bring Forward (oo-F) Moves selected object(s) forward one layer

Bring To Front (oo-[) Moves selected object(s) to the topmost layer
Send Backward (oo-B) Moves selected object(s) backward one layer
Send To Back (00-]) Moves selected object(s) to the bottom­

most layer

Scale. .. (oo-K)

Lets you scale the selected object(s) by a specific percentage. When you
scale an object, its aspect ratio (the ratio of height to width) is
maintained. Type the scaling percentage you want in the dialog box that

appears. Click the arrows to scale up or down by increments of 10%.

Borders cannot be scaled.

Rotate (oo-R)

Lets you rotate the selected object(s) by a specific number of degrees.

Choose Left 90 degrees, Right 90 degrees, or Other. If you choose
Other. . , a dialog box will appear. Type in the degrees you want, or click
the arrows to increase or decrease the number, or drag the rotation dia!.
You can also rotate an object by using the Rotate too!. Borders, seals,

and signature blocks cannot be rotated.
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Lets you flip the selected object(s) horizontally, vertically, or both. You
can also use the Flip tool on the tool palette to flip an object. Only
square, raw, and column graphics, ruled lines, and imported graphics can
be flipped.

Lock (Sß-Ll

Locks the selected object so it cannot be moved. When a selected object
is locked, the control handles change from solid to hollow. A locked
object cannot be ratated, flipped, scaled, resized, moved, deleted, or
ordered.

Unlock (Sß-Ml

Unlocks a locked object. The contraI handles will change from hollow to'
solid.

Align.. .

Lets you align two or more selected objects in a variety of ways. A dialog
box displays symbolic representations of the alignment options. Select
the alignment you want by c1icking the appropriate symbol.

CJ Aligns objects by upper left corners

E1 Aligns objects by upper edges

Aligns objects by upper right corners

Aligns objects by left edges

Aligns objects by centers, vertically and horizontally

Aligns objects by right edges

Aligns objects by lower left corners

Aligns objects by lower edges

Aligns objects by lower right corners
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TEXT MENU

Aligns objects along vertical midlines

Aligns objects along horizontal midlines

Text Settings

Lets you choose settings for text in a text block. Choose font, size, and
style settings.

Fant

Lets you choose a font for highlighted text in a text block, or for a

selected text block.

Style

Lets you choose a style for highlighted text in a text block or for a
selected text block. Choose: Plain, Bald, Itaiie, Underiine, Outline, or
Shadaw.

Size

Lets you choose a size for highlighted text in a text block or for a
selected text block. Choose a size from Extra Small to Extra Large (actual
point size varies, depending on the project and layout). Choose Smaller or
Larger to decrease or increase the size by one point. Choose Other... to

enter a specific point size.

Justificatian

Lets you set the justification for all of the text within a text block.
Choose: Left, Right, Center, or Full.

Placement

Lets you set the vertical placement for all of the text within a text block.
Choose: Tap, Center, Bottam, or Full.
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PROJECT MENU

Name Merge

Lets you merge names fram the name list. Select the line(s) you want to
merge-you can choose individual lines, a combination of lines, or all lines
fram the menu. The lines you merge will be placed at the location of the
cursor (in the same manner as a paste command). You can add text

before, after, or between the merged lines. However, the merged lines
will always be printed as separate lines. Edit and apply whatever styling
options you want to the text, including the merged lines.

Change Backdrop. ..

Lets you change the backdrop for the project without losing any other
parts of the design. When you choose Change Backdrop... , the Select a
Backdrap dialog will appear. Select the backdrap you want.

Change Layout. ..

Lets you change the layout for the project. All the current objects in the
layout will be discarded. When you choose Change Layout... , a warning
box will ask if you are sure you want to discard the current layout. If you
answer Yes, the Select a Layout dialog will appear. Select the layout you
want.

Page Blend

Lets you change the look of the page by adding a page color and a page

blend color. For more information, see the Adding and Changing Color
section in Chapter 4, the Basics.

For Post Cards Only

VIEWMENU

Front of Card
Back of Card

Zoom In (3€-+)

Takes you to the front of the card
Takes you to the back of the card
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Zooms in on the project to the next zoom level. The zoom will be
centered on the currently selected object or, if no object is selected, the
center of the document window.
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Zooms out on the project to the next zoom level. The zoom will be
centered on the currently selected object or, if no object is selected, the
center of the document window.

Fit To Window
25%
50%
Actual Size
150%
200%

Displays at a size that fits in the document window
Displays at 25% (1/4) actual size
Displays at 50% (1/2) actual size
Displays at the actual size it will be when printed
Displays at 150% actual size
Displays at 200% (twice) actual size

GOODIES MENU

Hide Baekdrop/Show Baekdrop

Lets you hide the backdrop. When you select Hide Backdrop, the
backdrop will disappear, leaving layout placeholders and objects in place.
The command toggles to Show Backdrop which you can select to see
the backdrop again.

Hide Plaeeholders/Show Plaeeholders

Lets you hide the layout placeholders. When you select Hide
Placeholders, the layout placeholders will disappear. The command
toggles to Show Placeholders which you can select to see the
placeholders again.

Hide Tools/Show Tools

Lets you hide the tool palette. When you select Hide Tools, the tool
palette will disappear. You can also hide the tool palette by double­
clicking the close box in the palette's upper-Ieft corner. When the tool
palette is hidden, this command toggles to Show Tools which you can
select to see the tool palette again.

Smart Graphie

Lets you access Initial Caps, Numbers, and Timepieces. These features
let you create custom square graphics to use in Print Shop Deluxe
Companion and Print Shop Deluxe projects.
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Lets you aeeess Make a Border, Merge Library and Modify Library
options. These features allow you to ereate your own borders, merge
libraries, and modify graphie libraries that you have ereated.

Name List

Brings up the Name List dialog. The first reeord in the eurrently seleeted
name list will be displayed. Use the Open button in the file seetion of the

dialog to open a different list.

Return Address

Brings up the Return Address dialog. The eurrent information will be
displayed.
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THE PRINT SHOP DELUXE COMPANION GRAPHICS EXPORTER

The Graphies Exporter is a utility that extends the value of The Print Shop
Deluxe Companion by allowing you to export Print Shop Deluxe graphies
(the clip art in The Print Shop Deluxe, The Print Shop Deluxe Co,:,panion
and eompatible Graphies Colleetions and Folios) in three different file
formats: EPSF (Eneapsulated PostScript Format), PICT. and AI (Adobe
Illustrator). Agraphie exported as EPSF will also include a PICT preview,
so if you use that file in a program that ean display PICT, you ean preview
the image. The exported graphies ean then be imported into a graphies.
word proeessing or desktop publishing program of your ehoiee.

Starting The Graphies Exporter

Open the folder eontaining the Exporter and double-c1iek on the Exporter
ieon. The title sereen for the Exporter will appear. Cliek OK to reaeh the
Exporter's Graphie Seleetion Window

Seleeting A Graphies Library To Export From

Before you ean export agraphie, you must seleet the graphies library
eontaining the graphie you want.

• Cliek on the Change Library button.
• Loeate the library file eontaining the graphie you want by double­

c1ieking on "Libraries".
• Highlight the library name and c1iek Open or double-c1iek on the

library name.
• A list of the graphies in that library will appear on the left.

Seleeting AGraphie To Export

• Highlight the graphie you want.
• Cliek on the Export button.
• A Save Dialog Box will appear.

The graphie file will automatieally be named with the graphie name and
the file format extension. The default file format is EPSF. If
you wish to export the graphie in PICT or Adobe Illustrator format, seleet
either the Plcr or AI radio button.

Use the table that follows to determine the reeommended file formats
when exporting graphies for use in other programs. If the applieation you
are using is not listed here, refer to the applieation's manual for
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eompatible graphies file formats.

EPSF PICT AI

Adobe X XIllustrator 3.2

Aldus
X XFreehand 3.0

Aldus X X
PageMaker 4.0

Aldus X X
Persuasion 2.0

Aldus SuperPaint 3.0 X

Claris X XFileMaker Pro 2.0

Claris Works 1.1 v3 X X

Microsoft X XPowerpoint 3.0

Publish It! 1.1 X

Canvas X X X(as EPSF)

Microsoft Word X

Quark XPress X X

Onee you have seleeted a file format, you must save the graphie

you are exporting. If you want to save the file in a different folder, seleet
the folder you want from the list. If you want to save the file
in a different loeation, open the menu above the list and seleet the
loeation you want.
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If you are having problems with The Print Shop Deluxe Companion,
select Help from the Apple menu to get Help within the program or refer
to the Index for the topic you are having trouble with. lf you still have

problems, call The Print Shop Deluxe Companion Technical Support
Hotline. Before you do, though, read through this chapter for some
possible solutions.

•
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Before Calling TechnicalSupport

lf you are having trouble printing, go through this list first. Make sure:

1) the system is properly set up

2) the printer cable is connected securely (push the cable on firmly
where it connects to the printer and the computer)

3) the printer power switch is on
4) the printer is on-line (selected)

5) the friction feed is off, and the tractor feed is on, if you are using

continuous feed paper
6) the paper is properly positioned
7) the printer's removable top, if any, is firmly in place.

The Print Shop Deluxe Companion
Technical Support Hotline

(415) 382-4750
Hours: Monday through Thursday, 7:00 am-5:00 pm Pacific Time

Friday, 7:00 am-4:00 pm Pacific Time

To turn off Virtual Memory and 32-Bit Addressing:

1) Pull down the Apple menu andselect Contral Panels. A window of
system control panels will appear.

2) Double-click on the "Memory" control panel.

3) Click on the Virtual Memory OFF button.
4) Click on the 32-Bit Addressing OFF button.
5) Close the "Memory" and "Control Panels" windows.
6) Restart your Macintosh.

To allocate additional memory for a program running under:

System 7.0 or 7.01

1) Single-click on the program icon (be sure the program is not in use).

2) Pull down the Finder menu and select Get Info.
3) A window will appear with two memory figures, a "Suggested size"



• • • • Troubleshooting

and "Current size". Highlight the current size by double-clicking on
the number.

4) Increase the memory by typing in a new number. The amount you
increase can vary, but a good starting point would be about 500K
above the suggested size.

5) Close the Get Info window, and start the program.

System 7.1

1) Single-click on the program icon, (be sure the program is not in use).
2) Pull down the Finder menu and select Get Info. A window will

appear with three memory figures - a "Suggested size", "Minimum
size", and "Preferred size".

3) The suggested size should equal the preferred size. Highlight the
minimum size by double-clicking on the number, then type in the
suggested size number.

4) The preferred size should be higher than the minimum size. The
amount can vary, but a good starting point would be about 500K
above the suggested size. Highlight the preferred size by double­
clicking on the number, then type in a higher number.

5) Close the Get Info window, and start the program.

To add memory to Print Monitor:

Follow instructions outlined above for allocating additional memory in
System 7.0 and 7.1. The Print Monitor file is in the Extensions folder
within the System folder. By default, Print Monitor is set to 80K.
Suggested size for avoiding memory errors is 350K.

To set your Macintosh to 256 or more colors:

1) Pull down the Apple menu and select Contral Panels. A window of
system control panels will appear.

2) Double-click on the Monitors control panel. A small box will display
your video options - Black & White, 4, 16, and 256*.

3) Select the 256 color option by clicking on that number.
4) Close the Monitors window.

* If 256, thousands, or more colors are not listed, or shaded gray, you will
need to add more video memory (VRAM) to your computer.

Conflicts with Extensions:

If your system freezes or you receive a "bomb" error message, a system
extension may be conflicting with your program. To temporarily disable
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your extensions, hold down the Shift key and Restart your Macintosh.
When the message, "Welcome to Macintosh. Extensions Off" appears,
release the Shift key.

Performa Info

At Ease is a simplified version of the Finder consisting of two main
groups - Programs and Documents. While At Ease is in operation, many

of the functions needed to configure the Macintosh are unavailable.

1) To temporarily disable At Ease - select Go to Finder from the File
menu. Since At Ease is an extension, it can also be disabled by
holding down the Shift key and restarting the computer.

2) To permanently disable At Ease - select Contral Panels from the
Apple menu. Double-click on the "At Ease Setup" control panel.
Click on the At Ease Off button. Close the At Ease Setup and
Control Panels windows. Restart the computer.

3) To add or delete a program fram At Ease - open the At Ease Items

folder in the System folder, and add or remove the program icon
or alias.

Launcher allows users to execute their programs through a single
window.

1) To add or delete a program from the Launcher - open the Launcher
Items folder in the System folder, and add or remove the pragram
icon or alias.

2) To disable Launcher - close the Launcher window.

The Performa always looks to the Documents folder first when
attempting to retrieve files. In order to avoid extra steps to find your

graphic libraries, make an alias of the Libraries folder and place it in the
Documents folder.

From the Finder,

1) Open the Print Shop Deluxe folder and dick once on Libraries.
2) Select Make Alias from the File menu.
3) Drag the Libraries alias to the Documents folder.



•
PRINTING TIPS

• • • Troubleshooting

Print Times

• The Print Shop Deluxe Companion provides a large selection of
high quality, richly detailed graphics and special text effects. On

occasion, printing numerous graphics and special text effects of
this complexity may require lengthy print times. Please allow
sufficient time for your project to print-we think you'lI find the

results to be worth the wait!

• Printing will go faster if .. Background Printing" is turned off. This
option is found in the Chooser. If you have at least 350K allocated
to the Backgrounder and prefer to regain control of your
application sooner, then leave this setting on.

Page Setup Tips

• If your printer does not have much memory, checking "Unlimited
downloadable fonts" in the Page Setup Options will help facilitate
successful printing.

Centering Output

• If your printed output is not centered properlyon the page, refer
to the More Options section on page 60 of this manual for Print
Alignment information.

Black & White vs. Grayscale

• If your printer has grayscale capabilities, grayscale printing will
provide higher quality output. Printing in black and white will
increase print speed and will substitute patterns for colors.

Printer and Page Setup settings can vary depending on your particular

setup. It's always advisable to follow the instructions provided with your
particular printer. The Print Shop Deluxe Companion has been designed
to accomodate the needs of most of the popular printers in use today. If
you do discover a' particular problem with your printer, try some of the

optional adjustments mentioned here.
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Aerogram 71
Aligning Objects 54, 96
Attributes

For Headlines 32-37
For Text Blocks 38-40

Autograph 40, 65
Backdrop 13, 24, 54-56, 62, 67, 69, 72

Lighten 27
Border Maker 84-86

Border Arrangement 85
Border Type 84

Borders 30
For Certificates 19, 63

Business Card 67-68
Certificate 62-67
Certificate Border 19, 63
Color Control Panel 45
Color, Text 39
Colors

Adding and Changing 49
Page Blend 49-50

Column Graphics 29
Crop Marks 68,74
Cut Out Envelope 70
Delete Tool 44
Deleting Objects 52
Design Elements 28
Design Operations 45
Duplicating Objects 53
Edit Menu 93
Envelope 68-71
EPSF Files

Importing 40
File Menu 90-93
Flip Tool 44,48
Font

Headline 33
Text Block 38

Font Size
Text Block 38

Frame T001 44, 47
Goodies Menu 99
Graphics Exporter 102
Hand Tool 43
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Headlines 32-37
Help 22
Importing Graphics 40
Initial Caps 79-82
Insert Name Entry 39
Installing the Program 8-10
Item Selector 45
Justify

Text 39
Headline 33

Layouts 14, 25-28, 54, 67, 69, 72
Locking Objects 53
Menus 45
Merge Library 86
Mini-borders 30-31
Modify Library 87
Moving Objects 52
Name List 60, 66, 67, 70, 73, 74-78
Name Merge 77

Selecting Names to Print 78
Navigation T001 71
New Object T001 43
Number (Smart Graphics) 82
Object Menu 94-97
Order 53
Page Blend 49
PICT Files

Importing 40
Pointer T001 42
Post Card 71-74

Back 72
Front 72

Preperfed paper 74
Print Alignment 60
Printing 21, 59

Business Cards 68
Certificates 67
Envelopes 70
Post Cards 73

Project Menu 98
ReadMe File 8
Ready Made Certificates 62
Resizing

Objects 50
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Text Blocks 39

Return Address 78
Revert to Saved 58, 91
Rotate Tool 44,47
Row Graphics 29
Ruled Lines 31
Save 20, 56
Scaling Objects 50
Seal 18, 40, 65
Select All 46
Selecting a Project 12, 23
Selecting Objects 46
Shadows 46

Headline 36
Signature Block 17, 40, 64
Smart Graphics 79
Square Graphics 29
Starting the Program 10
Stretching Objects 51
Style

Text 34
System Requirements 8
Text Block 16,37-40
Text Menu 97
Text Tool 42
Timepiece 83
Title Block 15, 40, 63
Tool Palette 41
Tools 41
Troubleshooting 104
TrueType Fonts 10,38
Type 1 Fonts 10, 38
Unlocking Objects 53
USPS Layouts 69, 72
Utilities 83
View 55
View Tool 44
View Menu 98-99
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